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1 Accessoal calcolatore

I calcolatoridisponibili in laboratoriosonodellestazionidi lavoro dellaSUN, sullequali gira
il sistemaoperativo UNIX Solaris2. Per poteraccederealle risorsedi calcolo �e necessario
disporredi un nomeutentee della corrispondentepassword: essisononecessariper farsi ri-
conosceredal sistemae perprevenirel'accessoa personenonautorizzate.I nomi degli utenti
sonopubblici, al contrariodellepassword chedevonoesseretenutesegrete. Ogni calcolatore
haunnomechelo distinguedagli altri, mai �le degli utentisonomantenutiin unazonacomu-
ne,accessibiletramitequalunquemacchina;non �enecessarioquindi utilizzaresemprela stessa
stazionedi lavoro.

Ad ognigruppovieneassegnatounsingolonomeutente,nellaformae01GRKyn, dovey �e
l'ultima cifra dell'annosolarein corso,eal postodi n occorreinserireil numerocorrispondente
al gruppo(esempioe01GRK61, e01GRK62, etc.. . ). La password �e inizialmenteimpostata
adunvaloreprede�nito,edovr�aesserecambiataal pi�u presto;si noti cheessapu�o essereanche
molto lunga,mai caratterisigni�cativi sonosolamentei primi 8. Inoltresianelnomeutentesia
nellapassword i caratteriminuscoliequelli maiuscolisonoconsideratidifferenti.

La proceduradi accessoal calcolatorevienedettaLogin, mentrequelladi uscita�echiamata
Logout. Tuttele stazionidi lavorosarannogi�aaccese,enonvannoMAI spente.Accendendoil
monitorsullo schermoapparir�auna�nestra conla richiestadelnomeutente.

Ai nostri�ni sar�anecessarioeffettuareunlogin remotosudi unaltrocalcolatore.Si trattadi
un server denominatocadlabsrv. perfareci�o premiamoil tastooptionse selezioniamoremote
loginechoosehostfromlist. Selezioneremo,aquestopuntoil computerdemononatocadlabserv
(ip: 192.168.6.128).Qualoranonfossepresentesar�anecessarioaggiungerlo.

Giungeremoquindiadunaulteriore�nestradi Login edovremoaquestopuntofornire i dati
necessari,nellaforma:

Please enter your username:

Occorrealloradigitareil proprionomeutente,e dopoaver premutoRETURN, alla successiva
richiesta:

Please enter your password:

inserirela password (quellaassegnatainizialmenteo, se l'avetegi�a cambiata,quellanuova),
chenonapparir�a sul video. Sesi commetteun erroreverr�a visualizzatoun messaggio,e biso-
gner�a ripeteretuttal'operazionedacapo.Nel casoin cui venissedimenticatala passwordbasta
informareunodegli assistentidi laboratoriocheprovveder�aadazzerarla.

Terminataconsuccessola fasedelLogin il calcolatorefar�apartireil sistemaoperativoa�ne-
strechiamatoCommonDesktopEnvironment(CDE). Nel casoin cui vi si presentasseunanuo-
va �nestra chepermettela sceltatra il CDEeOpenWindows, sceglieteil primo (selezionateloe
premetesul tastoOK); questarichiestanonvi verr�api�u fattain futuro.

3



2 CommonDesktopEnvir onmente UNIX

Laschermatainizialedopoaverlanciatoil CDEcomprende3 �nestre(User Registration 1,
Help Viewer e File Manager ), pi�u unabarradegli strumentipostanellaparteinferiore
delloschermo.

Ogni �nestra �ecompostadaunabarrain altocomprendenteil titolo ealcunibottoni,edalla
zonaprincipalecircondatadai bordi. Clickandoconil tastodestrosul titolo, o consinistrosul
bottonea forma di barrettapostoalla sinistradel titolo, si accedeal men�u della �nestra. Le
operazionieseguibili suuna�nestra sono:

Spostamento: posizionareil cursoredel mousesul titolo della �nestra, tenerepigiato il tasto
sinistroe spostareil mousenellaposizionedesiderata.Rilasciarequindi il tastosinistro.
La �nestra automaticamentevieneportatain primopiano.

Ridimensionamento: si possonocambiarele dimensionidi una�nestra agendosui suoibordi
medianteil tastosinistro.Il cursoredel mousein questocasosi trasforma,assumendola
formadelbordoo dell'angoloconunafreccia.

Foreground eBackground: quandoci sononumerose�nestre sullo schermo,partedi esse
sarannosovrapposte.Perportareuna�nestra in primo piano(Foreground)bastaclickare
sultitolo o sulbordoesternoconil tastosinistro;permandarlasullosfondo(Background)
occorreaccedereal men�u della�nestra dal titolo eselezionarel'opzioneLower .

Iconizzazione: clickandocon il tastosinistrosul bottonecon il puntinopostoin alto a destra
nella riga del titolo, la �nestra spariscee al suo postocompareuna icona nella parte
sinistradello schermo.Per riaprire la �nestra clickareduevolte in rapidasuccessione
sull'icona.

Chiusura: accedereal men�u della�nestra dal titolo eselzionarel'opzioneClose .

Una�nestra �eattiva(si dicechehail focus) quandoil titolo ei bordisonodi colorerosso-violet-
to anzich́egrigio. In ogni istanteesisteunasola�nestra attiva,ede' quellain gradodi accettare
i comandidalla tastiera.Perrendereattiva una�nestra, clickaresudi essao sul suotitolo; in
generela �nestra attiva �eanchein primopiano,maquestanon �eunaregolagenerale.

La barradegli strumentipostain bassopermettedi lanciarele applicazioniprincipali (File
Manager , Text Editor , Mail , etc.. . ) attraversodelle icone; i triangolini con il vertice
in alto rappresentanoinvecedei men�u checonsentonola sceltatra vari programmi,tra i quali i
terminali(Terminal ) e l'aiuto in linea(Help Manager ). La partecentrale,contraddistinta
daiquattrobottonichiamatiOne, Two, Three eFour , permettedi sceglieretraquattroscher-
mi (Workspace ) diversi, in mododa poterorganizzareil proprio lavoro pi�u razionalmente.
Perspostareuna�nestra daunoschermoadunaltro,selezionareOccupy Workspace . . .dal
men�u della�nestra,esceglierequellodesiderato.

Un altro modoper lanciarele applicazioniconsistenel richiamareun men�u premendoil
tastodestrodel mousesullo sfondodelloschermo,e selezionandoquindi l'opzionevoluta.

1Eliminarequesta�nestra clickandosullaopzioneNever Register ; fattoquestononla vedretemaipi�u.
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Prima di lasciareil laboratorioal terminedi ogni esercitazione�e obbligatorio chiudere
la sessionedi lavoro tramite il tastoEXIT presentenella barradegli strumenti,risponden-
do OKall successiva richiestanella �nestra Logout Confirmation . Le �nestre lasciate
aperte(terminali, �le manager, text editor, etc.. . ) verrannoautomaticamenteriaperteal login
successivo.

2.1 Shell di comandi: il terminale e la tcsh

Nonostantesi abbiaadisposizioneunsistemaoperativodotatodi interfacciagra�ca a�nestre, la
maggiorpartedeicomandicheverrannodescrittinelseguito �edi tipo testuale,evannointrodotti
facendousodi un interpretedi comandi,o Shell. Terminal �e una�nestra cheospitaunodi
questiinterpretidi comandi,nel nostrocasochiamatotcsh .

La �nestraTerminal �edotatadi unabarradi scorrimentopostasullatodestro,chepermet-
te tramiteil mousedi accederealle righegi�a scomparseoltre il bordosuperiore.In alternativa,
utilizzarei tastiPageUp ePageDown.

Il prompt del sistemamostrail nomedell'utente e il nomedel calcolatoresu cui si sta
lavorandocompresitraparentesigraffe eseparatidalsimbolo`@', seguitedall'indicazionedella
directorycorrente2 e terminatodal simbolo`> '. Esempio:

{e01GRK61@cadlab2}:/home/e01G RK61/ eser c1>

Per modi�care un comando,utlizzare il tastoBACKSPACE o le freccecursoree quindi
correggere.Perripetereuncomandoprecedentementeintrodotto,digitare! (puntoesclamativo)
seguito, senzaaggiungerespazi,dal numerod'ordine del comandodesiderato.Perconoscere
il numerod'ordine di un comando,impartire il comandohistory . Perrichiamarel'ultimo
comandoimpartito, digitare !! . In alternativa si possonorichiamarei comandiprecedenti
tramitela frecciacursoreversol'altro.

La �nestra Terminal pu�o esserearbitrariamenteridimensionataemodi�cata; il men�u po-
stosottoal titolo (accessibileancheconusandoil tastodestrodel mousesull'areadi lavorodel
terminale)consentedi cambiarela dimensionedel font, di eseguireoperazionidi copiae incol-
la e di con�gurareil terminale.Un modorapidoper copiarepartedi un comandoprecedente
consistenel selezionarecon il tastosinistrola porzionedesiderata,seguito dallapressionedel
tastocentraledel mouse,checopier�a immediatamentela selezioneapartiredallaposizionedel
cursore.

2.2 Panoramicadei comandiUNIX

Ogni �nestra di terminalepu�o accettaredei comandiUNIX, chevannoscritti con la sintassi
correttarispettandoanchele maiuscolee minuscole. Il �le systemdi UNIX �e organizzatoa
directorya partiredalla radice,e i nomi checontraddistinguonoil percorsosonoseparatidal

2In realt�a per non avereun prompt troppo lungo, l'indicazione della directorysi limita a visualizzarele tre
directoryimmediatamentesuperiorie non l'intero percorso.Ci�o �e comunquein generesuf�ciente per capirein
qualedirectoryci si trova.
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caratterè/ ' (slash),cheseusatodasoloindicala directoryradice.Peresempiola directorydi
lavorodel gruppo5 sar�a:

/home/ueln9905

I nomidei �le possonoesserelunghiapiacere,epossonoconteneretutti i caratterialfanumerici,
il puntoe l'underscore.I �le il cui nomeinizia conil puntosonoconsideratinascosti, cio�enon
appaiononegli elenchisenonlo si richiedeesplicitamente.Il �le costituitodalsolopuntoindica
la directorycorrente,e `.. ' �e la directorypadre.

ls Forniscela lista dei �le contenutinella directory corrente. Se si speci�ca un percorso
vengonovisualizzatii �le nelladirectoryindicata.Si possonousarei seguenticaratterijolly:

* : indicaunaqualunquesequenzadi caratteri.

? : prendeil postodi unsingolocarattere.

Mediantedelleopzioni �epossibilemodi�care il mododi visualizzazione;speci�candosulla
stessariga la sequenzà-l ' oltre ai nomi dei �le comparirannoanchei diritti di accesso,il
nomedell'utenteproprietariodel �le, la dimensionee la datadi creazioneo di ultimamodi�ca;
con`-a ' vengonovisualizzatianchei �le nascosti.

Esempio:

ls -la *log
-rw-r--r-- 1 ueln9906 2750 Mar 13 12:31 .mylog
-rw-r--r-- 1 ueln9906 478 Mar 13 12:31 CDS.log
drwxr-xr-x 2 ueln9906 512 Mar 19 15:59 dialog

pwd Mostrala directorycorrente.

cd nomedir Permettedi cambiarela directorydi lavorospeci�candoil nuovo percorso.Que-
stopu�o essererelativo rispettoaquellocorrente,assolutorispettoalla radice(il percorsoperci�o
deve iniziare con lo slash),oppurerelativo alla Homedirectorydi un utente. In quest'ultimo
casoil percorsodeve essereprecedutodal caratteretilde, seguito dal nomedell'utentescelto;
senonsi scrive il nome,masi lasciala tilde, si intendecomenomeutentequellochesi �eutiliz-
zatonellafasedi Login. In alternativasi pu�o usarela variabileHOME, precedutadal carattere$
perfareriferimentoalla propriaHomedirectory. Scrivendosolamentecd ci si posizionasulla
propriaHome.Pertornareindietronell'alberodelledirectoryutilizzareil comandocd ..

Esempi:

cd nomedir
cd /dir1/dir2/dir3
cd ˜/nomedir
cd ˜ueln9903/nomedir
cd $HOME/nomedir
cd ..
cd ../../dir2
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mkdir nomedir Creaunadirectoryconil nomespeci�cato.Esempio:

mkdir progetto

rmdir nomedir Cancellaunadirectoryvuota.Esempio:

rmdir progetto

cp sorgentedestinazione Copia il �le sorgentein destinazione.Seil nomedestinazione�e
unadirectory, allora il �le sorgentevienecopiatoall'interno della directory. Possonoessere
utilizzati i caratteri* e ? per fare riferimento a gruppi di �le. Il parametrodestinazione�e
semprerichiesto,quindi per copiarequalcosanella directory corrente�e necessarioindicarla
tramiteil punto.Esempi:

cp file1 file2
cp file nomedir
cp ../.cdsinit .
cp * ˜/progetto

mv sorgentedestinazione Spostaun �le nelladirectorydestinazione.Senelladestinazione
vienespeci�catounnomedi un�le (eventualmentenonesistente),il �le sorgentevienerinomi-
nato(eil �le destinazioneprecedenteeventualmentecancellato).Sesorgente �eunadirectory
edestinazione �eun nomeinesistente,la directoryvienerinominata.Esempi:

mv file nomedir
mv oldname newname
mv olddir newdir

rm nome�le Cancellaun �le. Attenzione:non vienechiestain nessuncasola conferma
dell'operazione. Esempio:

rm file1

cat nome�le Visualizzail contenutodi un �le. Sel'output �e troppolungo ed eccedele di-
mensionidella�nestrasi pu�o far interromperela visualizzazioneadognipaginaconil comando
more . Esempio:

cat file1 | more
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passwd Permettedi cambiarela propriapassword. Viene inizialmentechiestala password
attuale,e quindi quellanuova,chepersicurezzadeveesserescrittaduevolte. Il comandodeve
essereimpartitousandounaconsoletestualesulcalcolatorechiamatocadlabsrv . Lanormale
proceduradi login vi porter�a automaticamenteadagiresutalecalcolatore.Unavolta apertoil
terminaledigitare:

passwd
Old password: PiPPoBaudo
New password: 4tI9eR's
Retype new password: 4tI9eR's

Ultima nota: seavetedubbisullasintassidi un comando,sappiateche�e disponibileun help
in linea accessibiletramite il comandoman, seguito dalla parolachiave di cui volete avere
maggioriinformazioni.Esempio:

man passwd
man cd

3 Usodei tool Cadence

Le esercitazionidel corsodi Microelettronicasarannosvolte utilizzandounostrumentoCAD
prodottodallaCadenceDesignSystems.Conesso�e possibiledisegnareschematici,layoutdi
circuiti integrati,simularei circuiti, ecos�� via. Primadi lanciareil programma�eper�o necessario
preparareunadirectorypercontenereil lavoro, in mododanonmischiaresessionisuccessive
distinte.

Ogni progettovienevisto comeunalibreria, chesi va ad aggiungerea quellegi�a presenti
nel sistemadi sviluppo. In ogni libreria ci sonopoi delle celle, cheunite insiemeformanoil
progetto�nale. Sesi vorr�a fareriferimentoadun vecchioprogettosar�aallorasuf�ciente aprire
la libreria chelo contiene.Ogni cella a suavolta constadi diverseviste, cio�e modi diversidi
vederelo stessoblocco:anoi in particolareinteressanoquelladi layoutequelladi schematico,
che rappresentanodue livelli di astrazionedifferenti del circuito che si progetta. Una cella
pu�o ancheessereformatadaaltrecelle3, in un sistemagerarchicoin cui la radicedell'albero �e
l'intero circuito,mentrele foglie sonogli elementipi�u semplici.

Comegi�a detto, la prima operazioneda fare �e creareuna directory di lavoro per l'eser-
citazione. Si raccomandadi scegliere un nomemnemonico,per esserein gradoin futuro di
riconoscerlasenzaperderetempo.Sar�a comunquepossibile,daqualunquedirectory, accedere
a libreriecreatealtrove,purch́eappartenentiallo stessoutente.Esempio:

mkdir ˜/nomeprogetto
cd ˜/nomeprogetto

3Ma nondasestessa!
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Figura1: Finestraprincipaledi icfb

Sequesteoperazionivengonoeseguite dalla propriaHOME, dove si vieneautomaticamente
posizionatiterminatal'operazionedi login,si pu�o evitaredi scrivere˜/ neiprecedenticomandi.

A questopunto �e possibilelanciareil programmaIntegrated Circuit FrontendBackend
(icfb), con�guratoperutilizzarele tecnologiemesseadisposizionedallafonderiaAMS (Austria
Mikro Systeme).Nella lineadi comandooccorrespeci�careil tipo di tecnologia,lo strumento
di simulazionee il mododi funzionamento.Perle esercitazionidi Microelettronicasi consiglia
di dareil seguentecomando:

ams_cds -mode fb -tech c35b4 -nologo &

Il carattere& al terminedellarigadi comandoserveperlanciareil programmain background4,
in mododapotercontinuareadutilizzareil terminaleancheduranteil progetto.

Dopoun periododi inizializzazionein cui possonoveniremostratidei messaggisul termi-
nale,apparir�a sullo schermola �nestra principaledei comandi,mostratanella �gura 1. Essa
verr�a utilizzatapercrearei progettie perselezionarequelli gi�a esistentipereventualemodi�-
cheo nuovesimulazioni.In essainoltrecompaionospessoinformazioniedeventualimessaggi
di errore.In questomanualetroveretele spiegazionipersvolgeresolounapartedellefunzioni
messea disposizioneda icfb; per dettagliulteriori si rimandaalla documentazionedisponibi-
le in linea, attivabile medianteil bottonedenominatoHelp , presentein tutte le �nestre del
programma.

Verr�a inoltreapertaun'altra�nestra,chiamataLibrary Manager (vedi �gura 2), checonsen-
te di visualizzareil contenutodelle librerie e delle celle, raggruppandoeventualmentequeste
ultime in baseadellecategorieprede�nite.

Perusciredal programmaal terminedel lavoro �e suf�ciente selezionarel'opzione Exit
del men�u File . Eventualilavori nonsalvati nonandrannopersi,mail programmachieder�a la
confermadell'uscita,permettendoeventualmentedi salvarequantorimastoin sospeso.

3.1 Cir cuiti schematici

Lo scopocheci pre�ggiamo �e quellodi progettaree simularedei circuiti elettronici,e per far
questoil programmaci mettea disposizioneunafunzionedi SchematicEntry, cio�e un sistema
medianteil quale�e possibiledisegnare,utilizzandoi noti simboli, reti di elementiattivi e pas-
sivi (transistor, capacit�a, resistenze,. . . ). Ogni componentedeve esseremanualmentedisposto

4Senonsapetecosasigni�ca nonpreoccupatevi, non �e fondamentale.
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Figura2: La �nestra delLibrary Manager

sul foglio di lavoroecollegatoopportunamentemediantedei �li perottenerela funzioneprevi-
sta;perognuno�e possibileinoltre speci�caredei parametrichelo caratterizzano,o mantenere
quelli associatidi default al componente.Alla �ne, utilizzandoil simulatore,si pu�o veri�care
gra�camentel'andamentodelleusciteafrontedegli ingressichevengonodi voltain voltascelti.

Nei seguentiparagra�verrannodescrittele funzionipi�u utili perla realizzazionedegli sche-
matici,facendoin particolareriferimentoalla�gura 3,dove �emostratauna�nestracontenenteil
progettodi un invertitore.Nellasuccessivasezione3.2verr�aspiegatocomesimulareil circuito
cos�� progettato.

3.1.1 Apertura di uno schematico

Ricordiamocheperogni progettooccorrecreareunalibreria, cheal suointernoconterr�a delle
celle. Persistemidi modestacomplessit�a, quali quelli delleprime esercitazionidi Microelet-
tronica,in realt�a �e suf�ciente unasingolacella; all'aumentaredelle dimensioni,e soprattutto
perschemiregolari, �e invececonsigliabilel'uso di pi�u celle,chepermettonodi risparmiareuna
notevolemoledi lavoro.

Percreareunanuova libreria selezionaredal men�u File della �nestra principale(icfb) o
dalLibrary Manager il comandoNewequindiLibrary... . Apparir�auna�nestra (vedi�gu-
ra 4, sullasinistra)in cui bisogner�a inserireil nomedellanuova libreria5 e quindi premereOK.
Se�estataselezionatal'opzioneAttach to an existing techfile , verr�asuccessiva-
menterichiestodi indicareil TechnologyFile chesi desiderautilizzare,chenelcasodeiprogetti
realizzatiduranteil corsodi Microelettronicasi chiamaTECHC35B4. Questo�le descrive le
caratteristichedellemaschereutilizzatedal processodi fabbricazionee le regolegeometriche
perla loro correttarealizzazione,enon�equindinecessarioqualorasi intendarealizzareesimu-
lareesclusivamenteunoschematico;�eper�o obbligatoriosceglierneunoperil progettodi layout
di circuiti integrati.

5In realt�aseil comandovienedatodalLibrary Manager vengonomostratedue�nestre in successione,ognuna
contenenterispettivamentela met�adi sinistrae la met�adi destradella�nestra mostrataasinistranella�gura 4.
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Figura3: Lo SchematicEntrydi icfb

Creatala nuova libreriaoccorrecrearela cellachesi intendeutilizzareperil progettodello
schematico.Perfarequestoselezionaredalla �nestra di icfb o dal Library Manager il men�u
File -> New -> Cellview... , eventualmentedopoaver selezionatola libreria nel Li-
brary Manager. Apparir�a la �nestra di destradella �gura 4, in cui si pu�o scegliere la libreria
in cui crearela cella,dareunnomeallacellastessa(possibilmentediversodaunogi�aesistente,
altrimenti vienechiestosela si vuole sovrascrivere),e scrivereil nomedi unavista opportu-
na,chein questocasodeve essereschematic . Clickarequindi suOKperconfermarei dati
immessi.

L'aperturadi un lavoro salvato in precedenza�e invecepi�u semplice: �e infatti suf�ciente
selezionarenel Library Manager la libreria e la celladesideratae clickareduevolte in rapida
successionesullanomedellavistachesi intendeaprire.Altrimenti si pu�o utilizzareil comando
Open... del men�u File di icfb o delLibrary Manager.

Il risultatodelleoperazioniappenadescritte�ein ognicasol'aperturadi una�nestrapercrea-
re o modi�care schematici6, simile nell'aspettoa quellamostratain �gura 3. Essasi compone
di quattroareedistinte:

� La barra dei men�u, in posizioneorizzontalenellapartesuperioredella�nestra.

� La barra degli strumenti, in verticalesul latosinistro.

6E comevedremopi�u avanti,anchelayout.
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Figura4: Finestreperla creazionedi unnuovo progetto

� L' areadi lavoro, cheoccupain generela maggiorpartedello spaziodisponibile.

� La riga di stato, nellapartein basso.

Perchiuderela �nestra dello schematicoal terminedel lavoro, clickarenella barradei men�u
alla voceWindow eselezionareClose .

3.1.2 Operazioni nella �nestra dello schematico

Scopodel lavoro �e quellodi disegnarelo schemadi un circuito, utilizzandoopportunisimboli
convenzionali. Perfarlo il programmamettea disposizionedei comandi,chepossonoessere
attivati in modidiversi:

� attraversoi men�u,

� mediantegli strumenti,

� utilizzandoil mouseclickandonell'areadi lavoro,

� conla semplicepressionedi un tasto(hotkey) sullatastiera.

Nell'ultimo casofateattenzionechelettereminuscolee maiuscolehannoeffetti differenti. In
molti casi il comando�e attivabile in pi�u modi, e ogni utente�e libero di scegliere la soluzione
chepreferisce.In generaleinoltreognioperazionepu�o essereinterrottapremendoil tastoESC.

Alcuni comandirichiedonodi operaresuunoo pi�u oggetti,chedevonoessereselezionati:
per farlo �e suf�ciente puntaree clickarecon il tastosinistrodel mousesull'oggetto,chesar�a
evidenziato.Questaoperazionepu�o esserefatta:

� primadell'attivazionedelcomando,nelqualcasovieneassuntocomeriferimentoil punto
sucui si �eclickatoperfarela selezione,oppure

� dopol'atti vazionedelcomando,nelqualcasoverr�aspessorichiestodi puntareunoggetto
o unpuntodi riferimento.
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In alternativa, tenendopremutoil tastosinistroe muovendocontemporaneamenteil mouse,si
pu�o delimitareconun rettangoloun'area,e tutti gli oggettichesarannointeramentecontenuti
in essasarannoselezionati. Per selezionarepi�u oggetti, clickare su ognunodi essi tenendo
premutoil tastoSHIFT.

Nei prossimiparagra�sarannodescrittele operazioniprincipalie le loro caratteristiche;per
ognunavengonoinizialmenteelencatitutti i metodidi attivazione.Seguir�aunsempliceesempio
cheguidanellacostruzionedelloschematicodi un inverter(vediparagrafo3.1.4).

Inserimento di componentidi libr eria

men�u Add -> Component...
mouse Tasto centrale -> Add Component...

tastiera i
strumenti

Permettedi aggiungereun componentenello schematico.La suaattivazionecausal'appa-
rire di una�nestra, chiamataAdd Component, per la selezionedella libreria e dell'elemento
scelto.ClickandosuBrowse vieneattivatoil Library Browser7 checonsentela selezionedel
componentetramiteil mouse:nella libreria PRIMLIB , sottola vocemosfets (visibile sola-
mentese �e spuntatala casellacheattiva la classi�cazionein categorie),si trovanoi transistori
MOS (nmos4 e pmos4), e in analogLib le alimentazioni(vdc e vpwl ) e le masse(gnd ).
Perogni componentein genere�e possibilespeci�caredei parametrichene de�nisconole ca-
ratteristiche,condei valori di default chepossonoesseremodi�cati anchesuccessivamente.Il
tipo di vistadeveesseresymbol . Clickandoconil tastosinistrosull'areadi lavorosi creauna
istanzadell'oggetto,nellaposizioneindicata.

Realizzazionedei collegamenti

men�u Add -> Wire (narrow)
mouse Tasto centrale -> Wire (narrow)

tastiera w
strumenti

Consentedi collegaremedianteun �lo sottile8 dueterminali. Clickarecon il tastosinistro
nelpuntodovesi vuoleiniziareil collegamento.Rilasciareil tastoespostarsinel puntodi �ne:
clickarenuovamente.Senonsi vuolecontinuarela connessioneclickareunasecondavolta nel
puntodi �ne, altrimenticontinuare.

Duranteil tracciamentodei �li comparir�a un piccolo rombonelle vicinanzedel puntatore
del mouse,in generesui terminali dei componenti;sesi premeil tastos si otterr�a lo stesso
effetto di clickaresul puntoin cui si posizionail rombo,facilitandocos�� la realizzazionedella
rete.

7molto simile al Library Manager.
8Esisteunanalogocomandoper�li spessi,il cui funzionamento�edel tuttosimile.
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Inserimento dei pin di ingressoeuscita

men�u Add -> Pin...
mouse Tasto centrale -> Add pin...

tastiera p
strumenti

Perpoterfornire dei segnali al circuito, �e necessarioinseriredei pin per la comunicazione
conl'esterno. L'opzioneapreuna�nestra in cui occorrespeci�careil nomee il tipo (input ,
output , . . . ) del pin, chevienequindi posizionatosullo schematicoconil mouse,e piazzato
clickandocon il tastosinistro. �E possibilespeci�carepi�u nomi, e i pin sarannoquindi inseriti
nello schematicoin sequenza;in questocasoper�o occorrefareattenzionea modi�care il tipo
del pin, senecessario.

I pin sonoutili in duecasiin particolare:

� quandosi voglia fornire unostimolodi ingressoo inserireun caricotramiteun �le (vedi
pi�u avanti il paragrafo3.2.1);

� per il progettogerarchicoattraverso la creazionedi simboli dotati di ingressie usci-
te (3.1.3).

Nel primocasoi nomideipin sarannoi nodidausarenel �le di stimoloperindicarela posizione
di generatorie carichi,utilizzandola sintassidi SPICE. Nel secondocasoil simbolocheverr�a
generatoapartiredallavistaschematicaavr�aunnumerodi terminalidi ingressoedi uscitapari
al numerodi pin de�niti comeinput e output ; essisarannoutilizzabili esattamentecomei
terminalidi qualsiasialtrocomponentedi libreria.

Assegnazionedellepropriet �a ai componenti

men�u Edit -> Properties -> Objects...
mouse

tastiera q
strumenti

Quandoun componentevienecreatol'utente pu�o scegliere i valori dei parametri;spesso
tuttavia �enecessariomodi�carli, eperfareci�o si utilizzaquestocomando.Dopoaverloattivato,
selezionareil componentedesiderato,equindimodi�care apiacimentoi valori nella�nestra di
dialogochecomparesuccessivamente.Perterminarel'operazioneclickaresuApply , mentre
pernoneffettuaremodi�che clickaresuCancel .

Salvataggio

men�u Design -> Check and Save, Save, Save As...
mouse

tastiera X, S, CTRL-s
strumenti
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�E semprebenesalvare di tanto in tanto il lavoro, per proteggersida eventuali cadutedi
tensioneo crashdi sistema. Le tre opzioni qui descrittesonomolto simili, ma differiscono
peralcunipiccoli particolari. ConCheck and Save vieneeseguito un testsul circuito per
individuareeventualifonti di errore,quali peresempioterminali scollegati, primadi effettua-
re il salvataggio. Save salva semplicementeil lavoro nella libreria e nella cella selezionate
all'inizio, mentreSave As... consentedi cambiareil nomedellalibreriao dellacella.

Modi�che allo schematico

men�u Edit -> Stretch, Copy, Move, Delete, Rotate,
Undo, Redo

mouse Tasto sinistro (perselezionare)
Tasto destro (perripeterel'ultimo comando)

tastiera m, c, M, del , r , u, U
strumenti

Questoinsiemedi comandipermettedi modi�care in vari modi lo schematico.Il compor-
tamento�e leggermentediversoa secondachesianogi�a stati selezionatidegli oggettio meno:
nel primo casol'operazionevieneeseguitasulla selezione,e pu�o essererichiestoun puntodi
riferimento(perle operazionidi Stretch , Copy, Move eRotate ); nel secondocasooccor-
re puntarel'oggettocui si vuoleapplicarela modi�ca. Undo e Redo nonhannobisognodella
selezione.Segueunabrevedescrizionedi ogni comando:

Stretch : modi�ca le dimensionidi unoggetto,o spostaunsimbolomantenedoi collegamenti
gi�aeseguiti.

Copy : duplicaunoggettoesistente.

Move : spostaun oggetto.

Delete : cancellaun oggetto.L'operazionesi pu�o annullareconUndo.

Rotate : ruotaun oggetto.

Undo : annullagli effetti dell'ultimo comandoimpartito.

Redo : ripetel'ultimo comando.

Durantequesteoperazioni�e spessopossibilespecchiare il simbolodi un componentesianella
direzioneverticalesia in quellaorizzontale.Perfarlo premereil tastoF3, e sulla �nestra che
comparepremeresuSideways (�ip orizzontale)o suUpsidedown (�ip verticale).
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Zoom ePan

men�u Window -> Zoom In, Zoom In By 2, Zoom Out By 2,
Pan, Zoom To Fit

mouse Tasto centrale -> Zoom In, Zoom Out By 2, Fit
Tasto destro (creandoun rettangolo)

tastiera z, f
strumenti

I comandidi zoome panservono per spostarsie visualizzarea dimensioniopportunelo
schematico.SelezionandoPan viene richiestodi clickare sul punto che si desideraportare
al centrodello schematico;un effetto similaresi ottienecon i tasti di direzionedella tastiera,
permuoversidi circaun quartodelladimensionedell'areadi lavoro. Percambiarel'ingrandi-
mentosi pu�o procederein duemodi diversi: raddoppiandoo dimezzandol'areavisualizzata,o
selezionandounaregionerettangolare,cheverr�a espansaadoccuparetutta la �nestra. Un ulti-
mo comodocomando�e lo Zoom To Fit , chevisualizzaal massimoingrandimentol'intero
circuito.

Stampa

men�u Design -> Plot -> Submit...
mouse

tastiera
strumenti

Le esercitazionidi Microelettronicarichiederannounarelazionedel lavoro svolto in labo-
ratorio,e per questo�e necessarioincludereancheunacopiadello schematicorealizzato.Ci�o
si pu�o otteneresemplicementerichiamandoquestocomando:essocausal'apparizionedi una
�nestra in cui si possonosceglierediverseopzioni,quali la celladamostraree l'eventuale�le
sucui si vuoleavereunacopiain formatoPostscript. Sonodisponibili ulteriori opzioniattiva-
bili medianteil bottonePlot Options... , chedeterminanola stampantedautilizzaree la
dimensionedel foglio. �E anchepossibilefarsi spedireun messaggiotramitepostaelettronica
al completamentodell'operazione.Soprattuttonel casoin cui la stampantesia remota(cio�e
nonnei locali del laboratorio)�epreferibilestampareanchel' Header , edeventualmentealcune
note,in mododaesserepoi in gradodi distinguereil propriolavorodaquelloaltrui.

3.1.3 Creazionedi simboli per progetti gerarchici

Il progettodi circuiti complessirisultapi�u facilerealizzandoblocchielementari,edutilizzandoli
poi comecomponentia un livello gerarchicopi�u alto. La proceduradaseguirein questicasi �e
la seguente:

1. Creareunacellaelementarenellavistaschematic (peresempiouninverter).Peressere
utile,essadovr�aaverealmenounpin di ingressoe/ouscita,checomparir�acometerminale
nel simbolochesar�agenerato.
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2. Crearela vistasymbol per la cellaelementareappenaprogettata:utilizzareil comando
Design -> Create Cellview -> From Cellview... e clickare sul tasto
OKnelleduesuccessive �nestre.

3. Si apreuna�nestracontenenteil simbolo.Volendosi pu�o modi�care(coni soliti comandi
di Stretch e Move) l'aspettoesterioredel simbolo,avendocuradi non cancellarei
quadratinirossicherappresentanogli ingressie le uscite.

4. Creareun'altracella(conun altro nome,peresempiotop inv ) a livello gerarchicopi�u
alto,convistaschematic .

5. Aggiungereil componenteappenacreatonellanuovacella,conil comandoAdd Component ,
cercandolonellalibreriacuiappartiene(quellacreatadavoi), escegliendolavistasymbol .

Unacella formatadaaltrecellepu�o a suavolta diventareun simbolounico,permettendocos��
di raggiungereun numeroarbitrariodi livelli di gerarchia.Non �e invecepermessoinstanziare
unacellaall'interno di sestessa.Perun esempiogra�co dellaproceduraqui descrittasi veda
pi�u avanti la �gura 5.

La gerarchiadi un progettopu�o esserepercorsaarbitrariamentea partiredal livello pi�u alto
facendousodei comandinel men�u Design -> Hierarchy . Conessi�e possibileaprirein
lettura(Read) o in scrittura(Edit ) dei simboli, e tornareindietro di un livello (Return ) o
�no al livello iniziale direttamente(Return To Top).

3.1.4 Esempio

In questoparagrafoverr�apresentatoun esempiodi creazionedi unoschematicorappresentante
un inverter. Questoschematicoconterr�a transistor, collegamenti,pin di I/O ealimentazioni.Le
operazionidaeseguiresonole seguenti:

1. Dalla �nestra principaledi icfb clickaresuFile ; sulmen�u checomparescegliereNewe
quindiLibrary . Compareuna�nestra perla creazionedi unalibreria.

2. Inserireil nomedellanuovalibreria(peres.:esempio ) eclickaresuOK. Comparir�auna
�nestra perselezionareil TechnologyFile, scegliereTECHC35B4 epremereOK.

3. Selezionarela nuova libreria nel Library Manager e creareuna nuova cella tramite il
comandoFile -> New -> Cellview... ; inserirequindi il nomedellacella(per
es.: inverter ) e la vistaschematic . Quindi clickaresuOK; vieneapertala �nestra
contenenteil foglio di lavoro.

4. Perinserirei transistorMOSclickaresuAdd escegliereComponent : vieneapertala �-
nestraAdd Component . ClickaresuBrowse eselezionarela libreriaPRIMLIB , quin-
di la categoriamosfets . Selezionarenmos4, la vistasymbol equindiposizionarsicol
mouseall'interno del foglio di lavoro (zonanera)eclickarecol tastosinistro.

5. Ripeterel'operazioneprecedentescegliendopmos4 invecedi nmos4; battereESC per
terminare.
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6. Perposizionarei pin di I/O clickaresu Add e scegliere Pin ; digitare il nomedel pin
di ingresso(per es.: A) nella riga a destradi Pin Names; portareil mousesul foglio
di lavoro e clickarenellaposizionevoluta;portarsinuovamentesulla�nestra Add Pin ,
scrivereil nomedel pin di uscita,clickaresu input e tenendopremutoil tastosinistro
selezionareoutput ; posizionarlosul foglio di lavoro e realizzareil nuovo pin. Battere
ESC perterminare.

7. Per inserire nello schematicoalimentazionee massasi operacome al punto 4, sce-
gliendodal browseranalogLib -> Sources -> Globals e selezionandola vi-
stasymbol di gnd o vdd .

8. Perrealizzarei collegamenticlickaresuAdd escegliereWire (narrow) : posizionarsi
nelpuntodovesi vuolecominciarela connessioneeclickarecol tastosinistro;rilasciando
il tastospostarsinellaposizionedi �ne e clickarenuovamente;ripeterel'operazioneper
tutti i collegamentinecessari.

9. Persceglierei parametridei transistori(adesempiolarghezzae lunghezzadi canale)sce-
gliereEdit -> Properties -> Objects equindiclickaresuunodeidueMOS;
modi�care senecessarioi valori dellerigheWidth e Length ; clickaresuApply ; sul-
lo schematicoclickaresull'altro transistor, modi�care i parametrie clickaresuApply ;
clickaresuCancel perterminare.

10. salvareil lavoroclickandosuDesign e scegliendoCheck and Save .

3.2 Simulazione

Il tool Cadencepermettedi eseguiresimulazionirelative agli schematicicreati,visualizzando
l'andamentonel tempodei segnali (tensionie correnti)chesi intendonoanalizzare,a frontedi
ingressispeci�cati dall'utente(cfr. sezione3.2.1). Il simulatoreusato�e Spectre, unaversione
proprietariae miglioratadel simulatoreSPICE. Ogni componentevienesimulatoin baseadun
modellochenede�nisce le caratteristichee i parametriparassiti:i parametridel modellopos-
sonoesserestimatiin basealle informazionifornitedal progettistanelloschematico,o ricavate
mediantecalcoli dal layoutdel circuito. Nel seguito verr�a descrittala proceduraper la simula-
zionedi circuiti semplici,partendosolodallaspeci�caa livello di schematico.La sezione3.3.8
indicher�a quali modi�che sonoda effettuarequandola sorgenteper i dati del modellosia il
layoutstesso.

3.2.1 Descrizionedi stimoli ecarichi

La descrizionedegli stimoli in ingressoe dei carichi in uscitaal circuito chesi progettapu�o
avvenirein duemodidiversi:

� medianteun �le di testocheutilizza la sintassidi SPICE,

� mediantel'uso di appositiblocchipresentinellelibrerie.
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In entrambii casi,sia le sorgenti che i carichi non fannopartedel circuito chesi vuole rea-
lizzare, ma costituisconosolo il contorno(testbench), cio�e le condizioniesternein cui esso
deve lavorare. Notareche �e anchepossibileutilizzareun misto delle duetecniche.La prima
�e comodaspecieseoccorresimularesituazionimolto diverse,perch́e �e suf�ciente scriverepi�u
�le e indicarepoi quello correttoad ogni simulazione.La secondainveceha il vantaggiodi
non richiedereunaconoscenzaapprofonditadella sintassidi SPICE, ma bastasemplicemente
utilizzarei blocchidi libreriagi�adisponibili.

File di stimolo Mediantequesto�le �e possibiledescriverein modotestualeil testbench; il
nomedel �le �e sceltodall'utente,e verr�a poi indicatoin un appositoparametrodel simulatore
(vedi paragrafo3.2.2).Sempli�candomolto, �e necessarioscrivereunariga perogni ingressoo
uscita(pin) presentenelcircuito schematico,nellaforma:

nome nodo1 nodo2 comando valore

Perognunodei cinqueelementisegueunabrevedescrizionenel casoin cui si voglianospeci�-
caredelletensioni:

nome : pu�o esseresceltoapropriopiacimento,madeve iniziareconla letterav perle tensioni
(conla letterai perle correnti).

nodo1nodo2 : rappresentanogli estremitra i quali applicarela tensionechesi staspeci�can-
do. Generalmentenodo1 rappresentail nomedi un pin di ingresso,e nodo2 la massa,
indicatasemplicementeconil numero0. Perspeci�careunnodo,racchiuderlotraparen-
tesi quadree farlo precederedal simbolo#. Il nododi alimentazionevdd deve essere
sempreseguitodalcarattere! (puntoesclamativo).

comandovalore : indicail tipo di tensionechesi vuoleapplicare.Essapu�o esserecostante,o
variabileconunandamentoselezionabile.Perfornireunvalorecostanteutilizzare:

dc valore

Perottenereunaformad'ondalinearea tratti, utilizzare:

pwl ( t1 v1 t2 v2 t3 v3 ... )

Segueun esempioin cui vienespeci�cataunaformad'ondadi ingresso,il valoredell'alimen-
tazione,eunacapacit�a di caricodi 10pFpostasull'uscitadel circuito.

vin [#in] 0 pwl (0 0 1n 0 3n 5 8n 5)
vvdd [#vdd!] 0 dc 5
cl [#out] 0 1p
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Figura5: Esempiodi progettogerarchicoconusodi generatoriecarichi

Blocchi di libr eria E' possibileselezionaredeigeneratoridi formad'ondaedeicarichidiret-
tamentedallalibreriaanalogLib , nellecategorieSources -> Independent ePassives .
Essisonotrattatiesattamentecomei componentiutilizzati nelprogettoschematico,esonospes-
so dotati di parametrichene descrivono il comportamento.Riprendendol'esempioillustrato
nelcasodel �le di stimolo,si dovrebberoselezionareperl'ingressoin il generatorevpwl , per
l'alimentazioneil generatorevdc , e perl'uscita out il condensatorecap .

Poich́e questicomponentinonsonoin realt�a partedel progetto,masonoesterniadesso,si
suggeriscedi utilizzarli adun livello gerarchicosuperiorerispettoalla cellacherappresentail
circuitoveroeproprio.Questo�enecessariospecieseoccorreconfrontarela vistaschematic
e la vista layout della medesimacella per veri�care la loro corrispondenza(vedi paragra-
fo 3.3.7per la descrizionedella proceduradi LVS), che fallirebbein quantonon �e possibile
descrivere i generatoriindipendentinel layout. Per la creazionedi simboli e per il progetto
gerarchicosi rimandaal paragrafo3.1.3.

Peresempio,sesi desideraprogettareun invertere senevuoleveri�care il funzionamento
conun'ondaquadrain ingressoe unacapacit�a di carico,si pu�o strutturarela libreria nel modo
seguente:unacella chiamatainverter contenentei transistore i pin di ingressoe uscita,
convistesiaschematic , sialayout , siasymbol ; unasecondacellachiamatatest coni
generatori,i carichie il simbolodell'inverter. La �gura 5 illustra gra�camentel'esempio.
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Figura6: La �nestra principaledel simulatoreAnalog Environment

3.2.2 Preparazionedella simulazione

Primadi effettuareunasimulazioneoccorrespeci�careun certonumerodi parametriunavolta
per tutte. La sceltadelle variabili da visualizzaree la stampadei gra�ci pu�o essereinvece
ripetutapi�u volte anchenellastessasessionedi lavoro,comesi vedr�anellasezione3.2.3.

ComelanciareAnalogEnvironment/ Spectre

Il simulatoreSpectrevieneutilizzatodal tool AnalogEnvironment, lanciabiledalla�nestradello
schematicoselezionandoil comandoAnalog Artist dal men�u Tools . Verr�a apertaquin-
di unanuova �nestra attraversola qualesar�a possibilescegliere la con�gurazionedesiderata,
lanciarele simulazioniedosservarnei risultati.

Con�gurazione di AnalogEnvironment

Primadi eseguirela simulazioneveraepropriasi devonopredisporrealcunevariabili, comead
esempioil nomedello schematicodasimulareo del �le di stimolochedescrive gli ingressie i
carichi. Nei paragra� successivi verrannodescrittein dettaglioquesteoperazioni.Tra le varie
sceltedisponibili �e anchepossibileselezionareil simulatore;si raccomandaper�o di utilizzare
sempreSpectre, attivo perdefault.

Sceltadel progetto QuandoAnalogEnvironmentvienelanciatoassumeautomaticamenteche
lo schematicodasimularesiaquellodal qualeesso�e statoinvocato.Seci�o nondovesseavve-
nire, o sesi desiderasimulareun circuito differente,�e possibileselezionarlomedianteil men�u
Setup -> Design... o tramiteunodei tastipresentisulladestranella �nestra di Analog
Environment. Unaapposita�nestra di dialogopermetter�a poi di scegliere la libreria e la cella
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desiderate;clickarequindi suOKperconfermarela selezione.Il nomedel progettocomparir�a
nellasezioneDesign della�nestra di Analog Environment.

Sceltadella temperatura I risultati delle simulazionidipendonoanchedalla temperaturaa
cui operail circuito. Il valore normaleutilizzato �e quello della temperaturaambiente,cio�e
27o C, mapu�o esseremodi�cato selezionandoil comandoSetup -> Temperature... .

Sceltadel �le di stimolo Questaopzionedeveessereselezionatasolosesi vuoleutilizzareun
�le di stimoloperdescriveregli ingressiei carichi.Sesi desiderainveceutilizzarei componenti
di libreriaperil testbench, allorapu�o esseretranquillamenteignorata.

Il nomedel �le di stimolodeveessereinseritonella�nestradi dialogochesi ottienemedian-
teil comandoSetup -> Environment... , nell'ultima rigachehal'etichettaStimulus
File . Il percorsodel �le deve esserespeci�cato interamente,nel casofacendoloprecedere
dal caratterẽ per fare riferimentoalla proprioaHOME directory. Si pu�o ancheindicarela
sintassiutilizzatanel �le di stimolo, chenel casoillustrato nel paragrafo3.2.1corrispondea
cdsSpice .

Notarecheunavoltalanciatalaprimasimulazione,il �le nonvienepi�u riletto; sesi vogliono
effettuaredelle modi�che, richiamarela �nestra contenenteil nomedel �le, modi�carlo in
modoqualunque(peresempiocancellandol'ultimo carattere),clickaresul tastoApply posto
in alto, ripristinareil nomeequindi premereOK.

Sceltadel tipo di simulazione Esistonodifferentitipi di simulazione,selezionabilimediante
il men�u Analyses e l'opzioneChoose... i tre tipi principali sono:

� in transitorio,

� in regimesinusoidale,

� in regimecontinuo.

L'analisi in transitorio(Transient)esegueprima un'analisi in continuaper trovareil puntodi
lavoro e poi esegue l'analisi del transitoriovero e proprio. Bisognafornire l'istante di �ne
in corrispondenzadi Stop Time . L'analisi in regime sinusoidale(AC) esegueun'analisi in
frequenza.Richiedei parametridi frequenzaminima (Start ), massima(Stop ) e il tipo di
passo(lineare,logaritmicooautomatico).Alternativamentesi pu�oscegliereunafrequenza�ssa,
e far variarela temperatura,un parametrodi un componenteo un parametrodi un modello.
L'analisi in continua(DC) �e simile a quella in alternata,ma ovviamentea frequenzanulla.
Anche in questocaso�e possibilefar variaretemperaturao parametriin intervalli pre�ssati.
Attenzionea speci�careil correttoordinedi grandezzain tutti i campi: sesi stainserendoun
tempo,allora10 corrispondea 10 secondi,mentre10n a 10 nanosecondi.ClickaresuOK per
confermarele scelte.

L'algoritmo di calcoloutilizzatodurantealcunitipi di simulazione(in particolareperquel-
la in transitorio)pu�o esserepi�u o menoaccurato,a secondache si preferiscauna migliore
precisioneo unamaggiorevelocit�a. L'utentepu�o scegliere fra tre possibili opzioni, chiamate
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rispettivamenteconservative , moderate e liberal , clickandosul bottonecorrispon-
dente;la prima�e la pi�u lentamaanchela pi�u accurata,l'ultima la pi�u velocemai valori ottenuti
potrebberocontenereerrori maggiori. La differenzadi velocit�a tra i dueestremi,apprezzabile
soprattuttoper circuiti di mediee grandidimensioni,�e di circa tre volte. Si consigliaquin-
di di selezionareinizialmentela liberal e di veri�care i risultati solo alla �ne con quella
conservative ; la maggiorpartedellevolte nonsi noterannogrossedifferenze.

3.2.3 Esecuzionedella simulazione

Effettuatele scelteprecedentisi pu�o procedereconla selezionedellegrandezzedavisualizzare,
la simulazionee la stampa.

Salvataggiodellegrandezzedi simulazione

Durantela simulazionevengonocalcolati i valori delle tensionie delle correnti del circuito;
soloalcunedi essisonoper�o di interessepercapirneil comportamento,e quindi perdiminuire
il temponecessarioperla simulazionee lo spaziosudiscoperi dati,convieneselezionaresolo
quelleimportanti.Questaconsiderazione�evalidain particolareperschematicimoltocomplessi,
conungrannumerodi nodi.

Perdefaultvengonosalvatetuttele tensioni,manessunacorrente.Permodi�care questasi-
tuazione,dalmen�uOutputs , scegliereTo Be Saved equindiSelect On Schematic .
Sulla�nestra delloschematicoselezionarei segnalinel seguentemodo:

� tensioni: clickareconil tastosinistrosullanodo(�lo) corrispondente;

� correnti: clickarecon il tastosinistrosul terminaledel componentedi interesse;la cor-
rente�econsideratapositivaseentranteenegativaseuscente.

Perdeselezionareunagrandezza,clickarenuovamentesul nodoo il terminalecorrispondente9.
Se il progetto�e gerarchico,si possonoselezionareanchei nodi e i terminali all'interno dei
simboliscendendonellagerarchiaconil comandoDesign -> Hierarchy -> Descend
Edit... e tornandoindietroconDesign -> Hierarchy -> Return .

Sempredal men�u Outputs si pu�o selezionarel'opzione Save All... : verr�a mostrata
una�nestra chepermettedi salvaretutte le tensioni(il default), tutte le correnti (per l'anali-
si in transitorioclickaresu Select all DC/Transient terminal currents ), sia
tensionisia correnti,o nessunagrandezza.Nel casodi circuiti piccoli si pu�o sempresalvare
tutto,conun impattominimosui tempidi simulazione.

9 A volte pu�o risultarecomplicatoselezionareun terminaleper visualizzarnela corrente,perch́e il tool si
ostiner�a a evidenziareil nodo (�lo) ad essocollegato. In questicasi, durantela fasedi sceltadelle uscite,bi-
sognatemporaneamenteabilitarela solaselezionedei terminali invocandoil comandoEdit -> Select ->
Filter... della�nestra delloschematico,clickaresunone nellasezioneSchematic Objects nella�ne-
stradi dialogocheverr�a aperta,quindi abilitarepin , clickaresuApply , tornaresulla �nestra dello schematico
e selezionareil terminaledesiderato(dovrebbevenirecircondatoda unaellisse),clickaresu all nella sezione
Schematic Objects perripristinarela situazioneprecedente,equindi suOK.
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Selezionedellegrandezzeda plottare

La selezionedelleuscitedaplottarepermettedi visualizzare,dopola simulazione,i risultati in
formagra�ca. Questaoperazionepu�o essereeseguitamedianteunaproceduraanalogaaquella
della selezionedelle grandezzeda salvare. A questoscoposelezionaredalla barramen�u la
voceOutputs -> To Be Plotted -> Select On Schematic e quindi scegliere
i segnali sullo schematicocomeindicatoperla sceltadellevariabili dasalvare.

La selezionedi unagrandezzagi�aprecedentementesceltacausal'eliminazionedi talegran-
dezzadai risultati. I nodi e i terminaliselezionatisonoevidenziaticoncolori diversi,e i termi-
nalesonoancheracchiusiall'interno di unapiccolaellisse.Qualorala selezionedei terminali
risultassedif�coltosa, riferirsi al contenutodellanota9.

Avvio della simulazione

L'avvio dellasimulazionevieneeseguito tramiteil comandoSimulation -> Run, ovvero
con il tastocon il semaforoverde. Durantela simulazionevengonovisualizzatinella �nestra
di Analog Environmente in quelladi icfb unaseriedi messaggi,�no a quellodi terminedelle
operazioni.

Perle simulazioniin transitoriovieneperiodicamentevisualizzatoancheil temporaggiunto
e la percentualedi simulazionecompletata.Perbloccarela simulazioneagiresul tastocon il
semafororosso,oppureselezionareSimulation -> Stop .

Visualizzazionedei risultati estampa

Comedettoin precedenza,i risultati possonoesserevisualizzatiin forma gra�ca. Al termine
dellasimulazionevieneautomaticamenteapertauna�nestracontenentetutti i gra�ci deisegnali
selezionatiin precedenzasu un unicodiagramma.Vederecomeesempiola �gura 7, ottenuta
perun inverterNMOS like.

Perotteneneregra�ci separatisceglieredalla�nestra correntela voceTo Strip delmen�u
Axes ; perritornareadun diagrammaunicoselezionareTo Composite . Le stessefunzioni
si ottengonotramiteil tastinodenominatoSwitch Axis Mode, presentesullasinistradella
�nestra. Esisteanchela possibilit�a di ingrandireparticolarizonedel gra�co (men�u Zoom), e
di ottenerel'andamentodi unagrandezzain funzionedi un'altra e non in funzionedel tempo
(selezionareAxes -> X Axis... e sceglierela variabilechesi vuoleaveresull'assedelle
ascisse,indicandolain corrispondenzadellascrittaPlot vs. ).

Sela �nestra con i gra�ci vienechiusa(conWindow -> Close , pu�o essereriapertada
Analog Environmentscegliendo il tipo di simulazioneeffettuata(in transitorio, in continua,
etc.. . ) nel men�u Results -> Plot Outputs . Inoltre seunauscitanonerastatascelta
tra quelledadisegnare,la si pu�o comunquemostrareconResults -> Direct Plot che
permettedi indicarlamedianteil mousesullo schematico.

La stampasucartasi ottienedal men�u Tools-> Hardcopy... : la �nestra di dialogo
chevienemostratapermettedi sceglieresestampareancheunheaderconeventualinote,il tipo
di stampantee il formatodellacarta,o di sceglierela solastampasu�le postscript(rigaSend
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Figura7: Visualizzazionegra�ca dei risultati

Plot Only To File , dovebisognaindicare,quandoabilitata,il nomedel �le). Premendo
il tastoOKsi attiva la proceduradi stampa.

3.2.4 Esempio

Verr�aqui di seguitoillustratounesempiodi simulazionedi unoschematico,supponendochegli
stimoli e i carichisianostatirealizzatiutilizzandoblocchidi libreria. Le operazionidaeseguire
sonole seguenti:

1. Aprire lo schematicodi cui si vuoleeffettuarelasimulazionescegliendonelavistaschematic
nel Library Manager, eselezionandopoi il comandoFile -> Open... .

2. Nella �nestra dello schematicochesar�a aperta,invocareil simulatorecon Tools ->
Analog Environment . Apparela �nestra del simulatorein cui sar�a gi�a selezionato
il progettocorretto.

3. Impostareil tipo di analisimedianteAnalyses -> Choose... . Scegliereperesem-
pio un'analisiin transitoriodelladuratadi 50ns(l'ef fettivaduratadipendedaigeneratori
scelti).

4. Sceglierele grandezzedasalvareconil comandoSelect On Schematic nel men�u
Outputs -> To Be Saved , clickandosuccessivamentesuinodiesui terminaliche
interessano.

5. Sceglierele grandezzedaplottareconOutputs -> To Be Plotted -> Select
On Schematic ; questedevonoessereunsottoinsiemeo eventualmentecoinciderecon
quellesalavateal puntoprecedente.

25



6. Lanciarela simulazioneconSimulation -> Run.

7. Esaminarei risultati nella�nestra cheverr�aautomaticamenteaperta,contenentele forme
d'ondaprescelte.

3.2.5 Simulazioneparametrica

In certi casi �e utile simularelo stessocircuito in situazionidiversecherichiedonoil cambia-
mentodi unsingoloparametro(il valoredi unacapacit�a di carico,la tensionedi ungeneratore,
. . . ). Spessol'obiettivo �e confrontarele variesimulazioniin mododaevidenziarele differenze
e riconoscerequindi eventualicasipeggiori, criticit �a,ecos�� via. Altre volte �e invecenecessario
cambiareallo stessomodo le caratteristichedi tanti componenti,ma si vorrebbenon dover-
ne modi�care le propriet�a manualmenteper non perderetroppotempo. Analog Environment
metteperci�o a disposizioneuno strumentoper effettuarequesteoperazioniautomaticamente,
attraversol'uso di opportunevariabili, detteDesignVariables.

Percreareunavariabileimpartireil comandoVariables -> Edit... . Comparir�auna
�nestra chepermettedi dareun nomealla variabileedun valore,chepu�o essereun numeroo
unaespressione;il tastoAdd confermalescelte.La stessa�nestraconsenteinoltredi modi�care
o cancellarevariabili gi�aesistenti,chesonomostratenellalistasulladestra.ClickandosuOKsi
terminala fasedi de�nizione.

Una variabile de�nita nel simulatorepu�o essereutilizzata in uno schematicoall'interno
delleespressionidei parametridei componenti.Peresempio,nel campoCapacitance nelle
propriet�a di un condensatore,in luogodi un semplicenumero,si pu�o inserireunaespressione
comprendenteil nomedi unavariabile; durantela simulazionead essasar�a sostituitoil suo
valorecorrente.

La stessavariabilepu�o essereutilizzatapi�u volte,o nei parametridello stessocomponente,
o in pi�u componentidiversi. �E per esempiocos�� possibilevariarele dimensionidi un transi-
stor MOS mantenendocostanteil rapportoW=L, oppurecambiarecontemporaneamentepi�u
transistoriagendosuunasingolavariabile,usatacomemoltiplicatore.

Negli esempiprecedentiil valoreassuntoda unavariabiledeve essereassegnatomanual-
mentedal progettista;tuttavia a volte �e necessarioprovareuna seriedi valori e confrontare
poi i risultati. Per evitare di compierea manoquestaoperazionesi pu�o sfruttarela simula-
zioneparametricaautomatica:dopoaver de�nito unavariabile(assegnandoun valorequalun-
que),selezionarenella�nestra di Analog Environmentil comandoTools -> Parametric
Analysis... . Apparir�a la �nestramostratain �gura 8,dove �epossibileindicareil nomedel-
la variabile(o eventualmentedellevariabili), l'intervallo di variazione10 (o tramitegli estremi,o
indicandolo scostamentodaunvalorecentrale),e in�ne il numerototaledi puntidaesaminare,
dispostilinearmentenell'intervallo, oppuresecondodecadi,ottave,o suscalalogaritmica.

Peravviarela simulazioneselezionareAnalysis -> Start , equindiattendernela con-
clusione11. Verrannoeffettuatetantesimulazioniquantisonoi punti de�niti per la variabile,e

10Il valoreintrodottodurantela de�nizione dellavariabilesar�a ignorato.
11Bisognaaver sceltopreventivamenteil tipo di analisi (in transitorio,in frequenza,. . . ) e le grandezzeda

salvareedamostraregra�camentecomeindicatoneiparagra�3.2.2e 3.2.3.
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Figura8: Analisi parametricatramitevariabili di progetto

sar�a indicatoil valorecorrenteutilizzatosianella�nestra di �gura 8, nellariga in alto,sianella
�nestra di Analog Environment, nella sezioneDesign Variables (vedi �gura 6). Al ter-
mine verrannomostratetutte le forme d'onda in un'unica �nestra, sovrappostee distinguibili
medianteunaetichettacheriportail valoreassuntodallavariabileperogni curva.

I dati scelti per l'analisi parametricapossonoesseresalvati su �le (comandoTool ->
Save... ) e richiamati (Tool -> Recall... ). Conclusal'analisi parametrica,uscire
dalla�nestra di �gura 8 selezionadoTool -> Close... .

3.2.6 Analisi dellevariazioni del processotecnologico

Il progettoe la simulazionedi circuiti realizzaticon i tool Cadence(e pi�u in generalecon
qualunquestrumentodi progettazioneautomatica)vengonospessoeseguiti utilizzandoi modelli
di comportamentotipici dei componentichesi impiegano. Purtropponella realt�a i parametri
del processoproduttivo, la temperaturae la tensionedi alimentazionevarianoin un intervallo
controllabile,ma non strettissimo. �E opportunoquindi veri�care il corretto funzionamento
del circuito anchenei casiestremi,chiamaticorner, af�nch é essopossafunzionarein tutte le
condizionidi lavoro.

Condizioni estreme

Il tool Cadence,e pi�u in particolareil DesignKit dell'AMS, distinguevariecondizionidi fun-
zionamentoperi transistoriMOS,transistoribipolari, le resistenzeele capacit�a. Inoltreconsen-
te di variarein un intervallo daspeci�caresia la temperatura,sia la tensionedi alimentazione.
Tuttequestevariabili sonoutilizzabili contemporaneamente,dandoluogoaunnumerodi corner
abbastanzaelevato.

Permeglio capirecosaquestosigni�chi, si considerila Figura9 dove sonogra�camente
illustrati i punti di funzionamentodi un transistoreMOS. Il modellotipico tm (typical mean)
individuaunabendeterminatavelocit�a (e quindi ancheconsumodi potenza)pergli NMOS e i
PMOS.I quattrocorner inveceindividuanorispettivamente:
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Figura9: Puntidi funzionamentodei MOS

ws (worst speed) velocit�aminimaeminimoconsumodi potenza.

wz (worst zero) minima velocit�a per i transistoriNMOS (che quandoconduconoin genere
portanoal valorelogicozerol'uscita).

wo (worst one) minima velocit�a per i transistoriPMOS (che quandoconduconoin genere
portanoal valorelogicounol'uscita).

wp (worst power) massimoconsumodi potenzaemassimavelocit�a.

Le resistenzee i condensatori,oltre al modello tipico tm, dispongonoanchedei modelli
ws e wp. I transistoribipolari sonoinvececaratterizzatida tm (typical mean), hb (low-beta
low-speed), hb (high-betalow-speed) ehs (high-betahigh-speed).

Proceduraper la corner analysis

Nel progettodello schematiconon occorrenessunaattenzioneparticolareper fare uso della
corneranalysis, fattaeccezionenelcasoin cui si voglianovederegli effetti dellevariazionidella
tensionedi alimentazione.In questocaso�enecessariocheil generatoredi tensionecostantesia
parametrizzatoattraversounavariabile(peresempiochiamataVsupply ), cheverr�a utilizzata
in seguito in modoautomatico.Attenzionechein certi casioccorrefarvariareanchele tensioni
degli stimoli in ingressoal circuito in modoanalogoall'alimentazione,e per far questosi pu�o
utilizzarela stessavariabileanchenei generatoridi segnale.

L'analisi dei corner �e per certi aspettimolto simile ad unaanalisi parametrica,ed infatti
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utilizzaalcunistrumentiin comune12. Peraccedereadessasi selezionidalla�nestra principale
di icfb il comandoHit-Kit Utilities -> Corner Analysis , checauser�a l'aprirsi
di una�nestra. In essasi devonospeci�caretutti i cornerchesi voglionoesaminare,utilizzando
i seguentipassi:

1. Modi�care, sesi desidera,il campoupdate File Name, cheindividua il nomedel
�le in cui il programmaregistrale caratteristichedei cornercheverrannoscelti succes-
sivamente.L'estensionedeve essere.s e occorrericordarsiil nomedi questo�le per la
fasedi simulazione.

2. Dareunnomeal circuito. Questonomenondevenecessariamentecorrispondereal nome
dellacellachesi vuolesimulare.

3. Scegliere un rangedi temperaturaindicandoil valore minimo (Min ), tipico (Typ ) e
massimo(Max).

4. Scegliereun rangeperla tensionedi alimentazione,indicandoanchenel campoNameil
nomedellavariabileassociataal generatoreusatonelloschematico.

5. Scegliereun modellospiceperi MOS.Nel nostrocasovannobenecmos15 o cmos47.

6. Aggiungerei cornerclickandosulbottoneAdd Corner : verr�aaggiuntaunanuovariga
nella partebassadella �nestra nella quale �e possibilespeci�care le caratteristichedel
cornerchesi vuoleanalizzare.Si possonoaggiungereun numeroarbitrariodi cornerche
vengonodistinti dal loro numerod'ordine(generatoautomaticamente)edeventualmente
daunnomemnemonicofornito dall'utente.

AlternativamenteclickaresuAuto-Corner , chegeneraautomaticamentetuttele com-
binazionia partireda unaspeci�ca sui processcorner; questaspeci�ca si ottienesele-
zionandotutte le caratteristichechesi desiderasimularenella �nestra chevieneaperta
selezionandoquestocomando.

In entrambii casiannotarsiil numerodi cornerchesonostatide�niti, poich́esar�a neces-
sariopoi fornirlo al simulatoreperl'analisi.

7. Terminatala sceltadei corner, clickarein�ne suOK. Nella �nestra di icfb sar�a segnalato
cheil �le di update�estatoscrittocorrettamente.

A questopunto �e possibileaprire lo schematicoda simulare(segi�a non lo era)e far par-
tire Analog Environment. In essosi procedeesattamenteallo stessomododi unasimulazione
normale,avendocuradi speci�careil tipo di analisi(peresempioin transitorio)e le tensionie
correntidasalvareo mostrarenel gra�co. Veri�care inoltre cheesista,o nel casode�nirla, la
variabiledel generatoredella tensionedi alimentazione,e assegnarleun valoredi default (per
circuiti digitali pu�o essere5 V). Ci�o non impediscel'eventualesuccessiva analisimediantei
cornerconvariazionedellatensionedi alimentazione.

12Si consiglia tra l'altro di non effetuareuna simulazioneparametricacontemporaneamentead una corner
analysis.
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Primadi effettuarela corneranalysisoccorreancorafornirealcuniparametrial simulatore.
In particolarei passidaseguiresono:

1. Aggiungerela variabile corner medianteil comandoVariables -> Edit... ,
assegnandounvaloredi default qualunque(peresempio1).

2. SelezionareSetup -> Environment e inserirenel campoUpdate File il nome
del �le sceltoal passo1 durantela selezionedeicorner, avendol'accortezzadi ometterne
l'estensione.

3. SelezionareTools -> Parametric Analysis , e nella�nestra chesi aprir�a (vedi
Figura8) indicarecomenomedella variabilecorner , chedeve variarenell'intervallo
da 1 al numerodi cornerde�niti al passo6 della precedentefasedi scelta. Il campo
Step Control deve esseremodi�cato in modo da indicareLinear Steps , con
Step Size ugualea1.

4. Avviare in�ne la simulazionecon Analysis -> Start , esattamentecomein un'a-
nalisi parametrica,eattendernela conclusione.

Al terminedellasimulazionesar�amostratagra�camenteunafamigliadi curve,ognunadistinta
dalnumerodelcornercorrispondente.A questopuntosi pu�o veri�care l'ef fettivo funzionamen-
to del circuitousandotuttele tecnichegi�avistenel casodellasimulazionenormale.

3.3 Layout

La speci�ca di un circuito a livello di schematiconon �e suf�ciente per la suarealizzazionesu
silicio: perquesto�e necessarioinfatti fornire alla fonderialo schema�sico delleareeattive e
deicollegamenti,cio�e il layoutdelchipchesi intendefabbricare.Sebbeneesistanogi�a in com-
merciodei sistemidi sintesichesonoin gradodi generareautomaticamenteun layouta partire
dallo schemaelettrico,il nostrolavoro consister�a nel realizzaremanualmentequestatraduzio-
ne,controllandonepoi la correttezzamedianteun confronto.Avendounoschemadi quellache
sar�a l'implementazione�nale sar�a anchepossibileunasimulazionepi�u precisadel circuito: in-
fatti moltecapacit�a parassite,per esempioquelledovutealla lunghezzadei collegamenti,non
possonoesserecalcolatea priori, e vengonoquindi solo stimatecon un errorein generenon
trascurabile;a partiredal layout essepossonoesserecalcolatecon unaprecisionemolto pi�u
elevata,epoi utilizzatein simulazioneal postodellestime.

Il �usso di progettodi un layout �e mostratoin �gura 10: il primo passodi effettivo disegno
delcircuito �eseguitodadiversipassidi testpergarantireil funzionamentodellaversione�nale,
spessoiteratipi�u volteacausadi modi�che successive.Eventualierrorichevenganoriscontrati
in questefasirichiedonoin genereunavariazionedel layout,ed �e quindi fondamentalecercare
di limitarne il numeromedianteun attentoprogettoiniziale per non perderetroppo tempo.
Alcuni termininonchiarinella�gura 10sarannospiegatinelseguito,quandoverrannoaffrontati
unoperuno. Perquantoriguardala simulazionesi rimandainvecealla sezione3.2, in quanto
nonsi discostadaessasenonperpiccoli dettaglichesarannocomunquemessiin evidenza.
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Figura10: Flussodi progettodi un layout

3.3.1 Le maschere e le regoledi progetto

Il processodi fabbricazionedi un chip consistenel realizzare,in diversefasi,particolaristrut-
turesul silicio condeterminatecaratteristicheelettriche.L'uso dei droganti,degli acidi e degli
ossidideve essereper�o selettivo, cio�e deve essereapplicatosolo a determinatezonee nonad
altre;per farlo si utilizzanodellemascheree si applicaun processofotolitogra�co in gradodi
impressionareparticolarisostanzechevengonodepositatesul silicio, cambiandonele caratteri-
stiche.Il numerodellemascherepu�o variareasecondadelprocessoscelto,main ognicasoesse
dovrannoessereallineatecon grandeprecisioneper ottenereun risultatocorretto. Ci�o ovvia-
menteintroducedelle tolleranzedi cui si deve assolutamentetenerecontoduranteil progetto,
tramitedelleregole(DesignRules) chevengonofornitedal costruttore.

Il progettodi un layout consisteproprio nel disegnarele mascherenecessarieper la suc-
cessiva realizzazionedel chip. Comevedremonel seguito, il programmapermettedi scegliere
qualemascheradisegnare,e le visualizzasovrappostee allineate. Primadi procederecon il
progettodi un layout �e beneconoscerenel dettaglioil processodi fabbricazionechesi intende
utilizzare,e le regolechebisognaseguire.Essegeneralmenteindicanoqualisonole dimensioni
minime delle �gure geometricheper ogni mascherae le distanzetra diversi oggetti,sia nella
stessamascherachetramascherediverse.

Ogni mascheravieneidenti�cata tramiteun nomemnemonico,e vienevisualizzataconun
diversocoloree/o retinatura;un parzialeelenco�e riportatonella tabella1, dove sonoincluse
quelledi maggioreuso.Alcunedi essesonodi tipo negativo, cio�e il loro effettosi hanellaparte
esternaalle �gure geometrichedisegnate.Peresempio,sesi desideradrogareunadiffusionedi
tipo P, �e necessaria,oltre alla mascheraPPLUS, anchequellaNPLUSper impedirel'impianta-
zioneanchedi quest'ultimo;il drogaggiodi tipo N �e inveceautomaticosele mascherePPLUS
eNPLUSnonvengonomodi�cate.

Le regoledi progettosonoindicizzatetramitedei numerie sonoriportatesuun manualea
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Nome Descrizione
NTUB Well di tipo N susubstratoP
DIFF Area di diffusione. Pu�o esseredi tipo P o tipo

N asecondadel drogaggioapplicato.
FIMP Field implant� .

POLY1 Primostratodi polisilicio.
NPLUS Mascheraperdrogantedi tipo N� .
PPLUS Mascheraperdrogantedi tipo P.
POLY2 Secondostratodi polisilicio.

CONT Mascherapercontattitrametalloepolisilicio, o
metalloediffusione.

MET1 Primostratodi metallo.
VIA Contatto tra il primo e il secondostrato di

metallo.
MET2 Secondostratodi metallo.

� Mascheradi tipo negativo.

Tabella1: Alcunemascheredisponibili nel processoAMS

disposizionein laboratorio.L'esempiomostratoin �gura 11 riguardala mascheradi polisilicio
(quellapi�u scura)e le sueinterazioniconquelladellediffusioni. La regolaPO.W.1afornisce
le dimensioniminimedi un'areadi polisilicio, la PO.S.1le distanzeminime da un'altra zona
di polisilicio, PO.C.1daunadiffusione(notarecheil polisilicio pu�o passaresopraadunadif-
fusione,manonpu�o correreparallelamentetroppovicino); le restantitre regoleriguardanoin
particolareil progettodi transistoriMOS, e stabilisconodei valori minimi da rispettareper il
gatee le areedi sourcee di drain.

La violazionedelleDesignRulesrendeimpossibileil processodi fabbricazione,e bisogna
quindi tenerneconto in fasedi progetto. Il programmamettecomunquea disposizioneuna
proceduraautomaticadi controllo,chiamataDRC (DesignRuleCheck,vedi paragrafo3.3.5),
cheveri�ca il rispettodelle regole e visualizzatutti gli errori, corredandolieventualmentedi
una spiegazione. Durantele correzionioccorreancheprestareparticolareattenzionea non
violareunaregolacercandodi rispettarneun'altra: perprogettigrossi,sefatti male,spessosi
innescanodellereazionia catenachecausanoil completostravolgimentodellegeometrie,con
conseguenzedrammaticheanchesullefunzionalit�aeprestazionidel circuito.

3.3.2 Apertura di un layout

Perquantoriguardal'aperturadi una�nestra per il disegnodel layout,si rimandaa quantode-
scrittonellasezione3.1.1,essendoi passaggiesattamenteidentici. L'unica differenzariguarda
la vistadascegliere,poich́e in luogodi schematic occorreinserirela parolalayout .

Creataconsuccessola vistadi layout,comparir�a sullo schermouna�nestra, il LayoutEdi-
tor, simile a quellamostratain �gura 12. Analogamentea quellaper l'introduzionedi sche-
matici, anchequi troviamo la barra dei men�u, la barra degli strumenti, l' area di lavoro e la
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A(POLY1)

A(GATE)
4.3.1

4.3.2

4.3.6

4.3.3

GATE

POLY1

DIFF

4.3.1 Minimum POLY1spacingto DIFF 0:4� m
4.3.2 Minimum POLY1extensionto GATE 0:6� m
4.3.3 Minimum DIFF extensionof GATE 1:4� m
4.3.3 Maximumratioof PLOY1areato touchedGATEarea 100

Figura11: Esempiodi regoledi progetto

riga di stato. Inoltre, sopraalla barradei men�u, troviamoaltre informazionicheriguardanoin
particolarela posizionedel cursoresul chip rispettoall'origine, e gli spostamentirelativi adun
puntodi riferimento;tuttele misuresonoespressein micron.

In aggiuntaal LayoutEditor compareanchela �nestraLayerandSelectionWindow, visibile
sul lato sinistrodella �gura 12 conil titolo LSW: essapermettedi sceglierela mascherasucui
operare,edi renderevisibili omenoalcunedi esse,opzioneutilespeciequandocenesonomolte
sovrapposte.La �nestra LSWnonpu�o esserechiusa,masparisceautomaticamenteall'uscitada
icfb; la �nestra di layoutpu�o inveceessereeliminataselezionandol'opzioneClose nel men�u
Window.

3.3.3 Operazioni sulla �nestra di layout

L'interfacciautentedel LayoutEditor �e molto simile a quelladello SchematicEntry, in quanto
permettel'atti vazionedei comandinegli stessiquattromodi: men�u, strumenti,mousee ta-
stiera. Lo scopo�e tuttavia ora quello di disegnare�gure geometriche,chesarannoper lo pi�u
rettangolio poligoni, in genereconi lati orientatisecondogli assicartesiani.I comandiinfatti
assomiglianomoltoaquelli di uncomuneprogrammadi disegnoin duedimensioni.

Ricordiamocheperannullareunaoperazione�e suf�ciente premereil tastoESC. La riga di
stato�eancheutile perch́eriportal'operazionein corsoecosail programmasi aspettadall'utente
(esempio:selezionareun oggetto,clickaresuun punto,. . . ). Un comandopu�o incapsularneun
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Figura12: Il LayoutEditor e la LayerandSelectionWindowdi icfb

altro, �no adun livello massimodi 5 comandiin sospeso(esempio:si inizia adisegnareunret-
tangolo,poi si cambial'ingrandimentoperesserepi�u precisi,e quindi si terminail rettangolo);
raggiuntoquestolimite verr�avisualizzatoun messaggiodi errorenellarigadi stato.

Possonoessereselezionatetre tipi di entit�a:

� �gure geometriche

� bordi

� angoli

Posizionandoil mousesopraunadi questeentit�a, essasar�a evidenziatacon un contornotrat-
teggiato:un click conil tastosinistrola seleziona,e il contornodiventaunalineacontinua.In
alternativa,disegnandoun rettangolotenendopremutoil tastosinistrodel mouse,si seleziona-
no tutti gli oggettiinteramentecontenutinel perimetro.Perdeselezionare,clickarein unazona
vuotadel layout,oppurepremerei tastiCTRL-d. Comenel casodello schematico,la selezio-
ne pu�o precedereo seguire l'atti vazionedi un comando:nel primo caso�e spessonecessario
introdurreancheunpuntodi riferimentopercompletarel'operazione.

Sceltadella maschera

Primadi disegnareuna�gura �enecessarioselezionarela mascherasullaqualesi vuoleoperare.
Perfar questosi utilizza la �nestra LSW, clickandoconil tastosinistrosul nomeprescelto,che
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verr�a immediatamenteriportatonellapartealtadella �nestra e evidenziatodaun contornopi�u
spesso.Spessola stessamascheracomparediversevolte, seguita da unaestensionechepu�o
essere:

dg: drawing �E quella chesi usaper disegnareil circuito e cheservir�a per la fabbricazione
�sica del chip.

pn: pin Identi�ca i nomi dei pin (vedi anchela sezione3.1.2nella parterigurdantei pin) su
polisilicio, diffusioni,contattiemetalli.

nt: net Non utilizzataperle nostreapplicazioni.

In generalesi utilizzerannole mascheredi tipo dg, mentrequellepn sonoriservatealla spe-
ci�ca dei terminali di ingressoe uscita,il cui nomedeve essereidenticoa quelli usatiper lo
schematico.

Clickandoconil tastocentralenella�nestra LSWsi rendeunamascherainvisibile nell'area
di lavoro; clickandounasecondavolta essatornavisibile. L'effetto non �e peraltroimmediato,
ma �e necessariorichiedereesplicitamentela modi�ca selezionando,nella �nestra di layout, il
comandoWindow -> Redraw , oppurepremendoCTRL-r .

Realizzazionedi �gur e geometriche

men�u Create -> Rectangle, Polygon
mouse Tasto sinistro (perdelimitarela �gura geometrica)

tastiera r
strumenti

Nella quasitotalit�a dei casi le �gure geometrichesarannorealizzatemediantela compo-
sizionedi uno o pi�u rettangoli. Dopo aver attivato il comando,clickarecon il tastosinistro
del mousenell'areadi lavoro in corrispondenzadi unodegli angolidel rettangolochesi vuole
creare,quindi spostarsiin corrispondenzadell'angolo opposto(viene mostratocontempora-
neamenteil perimetrodel rettangolomentresi muove il mouse)e clickareunasecondavolta.
Apparir�aun rettangolodel coloree retinaturacaratteristichedellamascheraselezionata.

Un poligonosi pu�o ottenerein duemodi:

1. Utilizzare l'apposito comandoper crearepoligoni. Inserireuno ad uno clickandocon
tastosinistrodel mousei vertici delpoligono,�no a tornareesattamentesulprimo.

2. Crearetanti rettangoliadiacenti(o anchesovrapposti)per formarela �gura desiderata.
Selezionarlitutti (clickaresuognunodi essitenendopremutoil tastoSHIFT), e poi atti-
vareil comandoMerge (Edit -> Other -> Merge , oppurepremereM). Si otterr�a
il poligonocircoscrittoai rettangoli,cherisulter�a ancheselezionato.Perdeselezionarlo
premereCTRL-d.

Altre �gure, quali diagonalio ellissi, possonoessererealizzatein modoanalogo;tuttavia
essenonsonomolto utili, specieperprogettipiccoli.
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Misura delledistanze

men�u Misc -> Ruler, Clear Rulers
mouse

tastiera k, K
strumenti

Perrispettarele regoledi progettobisognaconoscereconesattezzale dimensionidelle �-
guregeometrichee le loro distanze.La riga sovrastantela barradei men�u riporta la posizione
del cursoredel mouserispettoall'origine, conunarisoluzionedi 0:1� m, nellevoci X: e Y: , e
la distanzarispettoall'ultimo puntodi riferimentointrodottoin dX: , dY: eDist: , rispettiva-
mentelungol'asseorizzontale,verticalee lungola rettacongiungentela posizionedelmousee
il puntodi riferimento.

Sebbeneutili, i dati di posizionedel mousenonsonopermamenti(spostandoil mouseessi
cambiano)e spessorichiedonoqualchesempliceoperazionealgebricaperottenereil risultato
cercato.Unaindicazionepermanentesul layoutdelledistanzesi pu�o tuttavia otteneremediante
i Ruler, cio�e delle scalein micron tra duepunti scelti dal progettista.Dopo l'atti vazionedel
comando,il primo click del mouseselezional'origine, e il secondol'estremoopposto;la scala
di misuraseguei movimenti delmousetra la sceltadelprimoe delsecondopunto.

Unavoltapiazzato,il Rulernonpu�o essereeliminatoconla solitaopzionedi cancellazione,
né copiatoo mosso.Pertoglierlo bastainvocareil comandoClear Rulers , checanceller�a
tutti quelli �no aquelmomentocreati.Non �epossibileunaeliminazioneselettivadei Ruler.

Modi�che al layout

men�u Edit -> Undo, Redo, Move, Copy, Stretch,
Reshape, Delete

mouse Tasto centrale -> Move, Copy, Delete
Tasto destro (perripeterel'ultimo comando)

tastiera u, U, m, c, s, R, del
strumenti

Tutti questicomandi,eccettoUndo e Redo, operanosu uno o pi�u oggetti,ancheappar-
tenentia mascherediverse. Comespiegato in precedenza,la selezionepu�o essereeseguita
primao dopol'atti vazionedel comando,manel casodello stretchin certi casisi haun effetto
leggermentediverso:

Undo : annullal'ultima operazioneeseguita,ripristinandoil layoutal suostatoprecedente.

Redo : ripetel'ultimo comando.

Move : spostaunoo pi�u oggetti.

Copy : copiaunoo pi�u oggetti.

Stretch : modi�ca le dimensionidi uno o pi�u oggetti. Se si attiva il comandoe poi si se-
lezionaun'arearettangolare,tutti gli oggetti interamenteinclusi nel perimetrosaranno
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semplicementemossi,mentrei bordi e gli angoli che intersecanoil perimetrosaranno
accorciati/allungati.

Reshape: modi�ca la formadi unoggetto.

Delete : cancellaunoo pi�u oggetti.

Assegnazionedei nomi dei pin

men�u Create -> Pin...
mouse

tastiera CTRL-p
strumenti

Comevedremonellasezione3.3.7,perpoterveri�care automaticamentela corrispondenza
tra un circuito schematicoe un layout, �e necessariospeci�careanchesu quest'ultimoi nomi
dei pin. Comeper le altre �gure, si utilizzerannodelle maschere,chenon farannoper�o poi
partedel processoproduttivo. Questemascheresonoidenti�cate dall'estensionepn (confronta
la sezioneriguardantela sceltadellemaschere).

Nella �nestra cheapparequandovieneinvocatoil comando,speci�careil nomedel pin (o
deipin, vistochesenepossonorealizzareanchepi�u di unoperognicomando),cos�� comecom-
paiononello schematico,scegliendoneancheil tipo corretto(input, output,. . . ). Si suggerisce
anchedi attivarel'opzioneCreate Label permostrareil nomedel pin. Il pin pu�o esseredi
tipo simbolico(�e il default), del qualesi deve speci�careil tipo (Pin Type ) e la dimensio-
ne (opzionemanual pin ), oppuresenepu�o scegliere la forma abilitandoil tastinoshape
pin . Nel primo caso,senzachiuderela �nestra, �e suf�ciente piazzareil pin nella posizione
desiderata;nel secondocaso,dopoessersiassicuratichenella �nestra LSWsiaselezionatauna
mascheradi tipo pn, occorretracciaredei rettangoliin corrispondenzadelle linee di metallo
o polisilicio corrispondentiagli ingressie alle uscitedel circuito. Attenzionea non toccare
linee distintecon lo stessopin, altrimenti si ricever�a un messaggiodi errorenelle successive
fasi di test. Sesonogi�a note,speci�careanchele possibili direzionidi accessoper la fasedi
routingautomatica,quandoprevista(vedisezione4.2.1).PremerequindiHide o Cancel per
terminarel'operazione.

Modi�ca dellepropriet �a

men�u Edit -> Properties...
mouse Tasto centrale -> Properties...

tastiera q
strumenti

�E possibilemodi�care le propriet�a di qualunque�gura geometricadisegnata.Invocandoil
comandoeselezionandounoggettocompareuna�nestrachemostrail tipo dellamascheraegli
estremidella �gura: per i rettangolile coordinatedei quattroangoli (Left , Right , Bottom
e Top), e per i poligoni la lista dei vertici. Per i pin si aggiungonoanchele informazioni
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di connessione(Connectivity ), con in particolarela direzionedel terminale(input o
output ). Le modi�che vengonoconfermatepigiandoi bottoniOKo Apply , mentreCancel
annullal'operazione.

Sesi selezionanopi�u oggetti,ancheappartenentia mascherediverse,le propriet�a vengono
comunquemostrateindividualmente,ma �e possibilepassaredaun elementoall'altro tramitei
tastiNext ePrevious .

Pan eZoom

men�u Window -> Zoom In, Zoom In by 2, Zoom To Grid
Zoom Out by 2, Pan, Fit All

mouse
tastiera z, CTRL-z , CTRL-g, Z, tab , f

strumenti

Comenel casodello schematico,ancheper il layout l'operazionedi Pan(traslazioneoriz-
zontaleo verticale)�e attivabilemediantele freccecursore.L'invocazionedirettadel comando
richiedeinvecela speci�cadi un punto,chesar�a portatoal centrodell'areadi lavoro.

Si pu�o ingrandireo rimpicciolire di duevolte l'immagine,oppureselezionarel'area di in-
teresseconun rettangolo.L'utile comandodi Fit All determinail massimoingrandimento
talepercui tutto il circuito risulti comunquevisibile.

Salvataggio

men�u Design -> Save, Save As...
mouse

tastiera f2
strumenti

Di tantoin tantoconvienesalvareil layoutchesi stacreando.L'operazioneSave utilizza le
informazionidi libreriaecellainseriteal momentodell'aperturadellavoro,Save As permette
invecedi modi�carle.

Stampa

men�u Design -> Plot -> Plot Cell View.
mouse

tastiera
strumenti

La stampadellayout�enecessariapercorredarela relazionedi ogniesercitazione.Dopoaver
invocatoquestocomandocompareuna�nestra in cui �epossibilescegliereil tipo di stampante,la
dimensionedellacarta,il numerodellecopie,e l'inserimentodi un header(sempreconsigliato
sela stampante�eremota)edi eventualinotepersonaliperdescrivereil lavoro. Volendoottenere
un �le Postscript, attivarel'opzione Plot to File e speci�careun nomevalido. Clickare
quindi suOKperottenerela stampaeffettiva.
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3.3.4 Esempio

In questobreve paragrafosarannodescrittepassopassole operazioniper la creazionedi un
transitoreNMOS. Non sarannopresein considerazionituttavia le regole di progetto. Potete
fareriferimentoalla �gura 12nellapartebassaperavereun'ideadel risultato.

1. Dalla �nestra principaledi icfb clickaresuFile ; nel men�u checomparescegliereNew
-> Cellview ... .

2. Inserirenella�nestra chevieneapertale informazioniLibrary Name, Cell Namee
View Name, enelcasoconfermarela creazionedi libreriaecella.Nellarigariguardante
la vista deve comparirela scrittalayout . Vengonoapertele �nestre LSWe il Layout
Editor.

3. Selezionarela mascheraDIFF (dg) , premereil tastor e tracciareun rettangolo,che
sar�a di coloreverdecon unaretinaturaabbastanza�tta. Essorappresentala zonaattiva
del transistore.Disegnareun secondorettangolo,spostatorispettoal primo, per poter
polarizzarecorrettamenteil substrato.

4. Selezionarela mascheraPOLY1 (dg) etracciareunsecondorettangolo,sovrappostoal
primo mapi�u stretto,e sporgentedaentrambii lati delladiffusione.Essosar�a di colore
rosso,con retinaturasimile a quelladella diffusione. Questapartein polisilicio sar�a il
gate.

5. Sempreconlastessamaschera,disegnareunazonapi�ugrandeall'esternodelladiffusione,
maparzialmentesovrappostaal gate;quest'areaospiter�a il contattodel gate.

6. Selezionarela mascheraCONT (dg) edisegnareduerettangoli,dapartiopposterispetto
al gate,mainteramentecontenutinelladiffusione.I duecontattiservirannopercollegare
sourcee drainallepistein metallo.Tracciareun terzorettangolonellapiazzolain polisi-
licio disegnataal puntoprecedente.Ripetereancoral'operazioneperl'areadi diffusione
necessariaperpolarizzareil substrato.La mascheradeicontatti �edi coloregiallo.

7. Selezionareprimala mascheraNPLUS (dg) e successivamentePPLUS (dg) e dise-
gnareduerettangoliintorno alla diffusionedi polarizzazionedel substrato.Questidue
rettangolidevonoessereperfettamentesovrapposti.

8. Selezionarela mascheraMET1 (dg) e tracciaretrerettangoli:il primodevecollegareil
contattodi substratoconunodeidueterminalidel transistore,il secondoeil terzodevono
ricoprireinteramentei duecontattirimastiscoperti.Questamaschera�eblu conretinatura
spigata.

9. SelezionarelamascheraMET1 (pn) ; invocareil comandoCreate -> Pin... , scri-
verei trenomichesi voglionoassegnareai terminali,selezionareshape pin el'opzio-
nerectangle , quindi disegnarei rettangoliin corrispondenzadel contattodi gate,del
contattodi substratoedel contattorimastononcollegatodel transistor. Se�estataattivata
l'opzioneCreate Label , posizionareanchele scrittein prossimit�adi ogni contatto.
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3.3.5 DRC

La proceduradi DesignRuleCheck permettedi veri�care in modoautomaticoil rispettodelle
regoledi progetto,segnalandoperogni violazionela posizionee il numeroidenti�cativo della
regolaviolata.Un progettoprontoperla fabbricazionedevepassarequestotestsenzaunerrore,
ecos��pureperpoterproseguireconi successivi controlli e la simulazione.

Perattivarla selezionarel'opzione DRC... dal men�u Verify nella �nestra del layout.
Comparir�a una�nestra chepermettedi modi�care diversi parametri;nel nostrocaso�e suf�-
cienteveri�care cheil �le tecnologicosia TECHC35B4. Clickarequindi su OKe veri�care
l'andamentodel testnella �nestra principaledi icfb. Al terminesar�a mostratoun riassuntodi
tutti gli errori,o sperabilmentela frase:

Total errors found: 0

Nel casosfortunato,le violazioni sarannoevidenziatesul layouttramitedellelineebianche
lampeggianti,i Markers, chedelimitanole areescorrette.Perognimarker �epossibilerichiede-
re unaspiegazioneselezionandoil men�u Verify -> Markers -> Explain . Anchese
l'errore vienecorretto,il marker nonsar�a eliminatosenondopola successiva esecuzionedel
DRC. In alternativa utilizzare i comandiVerify -> Markers -> Delete, Delete
All... .

Esistonopoi dueopzioni avanzatechepermettonodi risparmiareun po' di lavoro nel di-
segno del layout. Nel processoAMS infatti, la mascheraFIMP deve semprecoinciderecon
NTUB, e la mascheraNPLUSdeve coinciderecon PPLUS. Essesonoentrambemascherene-
gative, il cui effetto �e percio' solo al di fuori della zonadelimitata. Visto chel'informazione
�e pertantoridondante,la proceduradi DRCpermettedi generele maschereFIMP e NPLUS
automaticamentea partiredallealtredue;perfarlo clickaresuSet Switches e selezionare
generate NPLUSegenerate FIMP13.

3.3.6 Extraction

Primadi poterveri�care la correttezzadel layoutrispettoallo schematico,bisongaidenti�care
nellegeometriedisegnategli elementiattivi, quelli passivi, le capacit�aparassite,i collegamenti
e i terminalidi input e output. Anchequestaoperazionepu�o essereautomaticamenteeseguita
dal programma:perattivarlaselezionareVerify -> Extract... , e immetterenella�ne-
stradi dialogochevienemostratalo switch capall , clickandosu Set Switches . Nella
�nestra di icfb verrannomostratii vari passaggi,chesi concludonoin generecon il successo
dell'operazione.

Terminataquestafase,perprocedereulteriormenteoccorrecaricarein luogodellayoutla vi-
staExtracted . Selezionarepertantonelmen�u Design l'opzioneLoad... , enella�nestra
Open File cheverr�a aperta,scegliereperView Namela parolaextracted (o utilizzare
il Library Browser. Nell'areadi lavoro comparir�a quindi il layout,privatodi alcunemaschere,
econl'identi�cazione dei transistornellazonadi gate.

13Perselezionarecontemporaneamentedueopzioni,clickaretenendopremutoil tastoCTRL.
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Figura13: La �nestra di controllodi LVS

3.3.7 LVS

Caricatala vistaextracted si pu�o procedereconla veri�ca automaticadellecorrispondenze
tralayoutecircuitoschematico,eallasuccessivafasedi Back Annotation(vediparagrafo3.3.8).
Questaoperazione�enotaconil nomedi LVS, acronimodi LayoutversusSchematic.

A partiredal men�u Verify , selezionareLVS... : comparela �nestra mostratain �gu-
ra 13,cheservir�aancheperla BackAnnotation.In genereil tool �e in gradodi riempirecorret-
tamentei campinecessaripereffettuarele veri�ca, ma �e sempremeglio controllarechei nomi
identi�cativi di libreria,cellaevistasianocorretti. Il processodi LVS vienelanciatoclickando
sulbottoneRun, postonellapartebassa;nella�nestradi icfbvengonomostratialcunimessaggi,
terminatidallascritta:

LVS job is now started...

La proceduraposegue il suo lavoro in background, cio�e in parallelorispettoal restodel
programma.Al terminevienemostratoun messaggiocheinforma l'utente circa il successoo
menodellafunzione;il successoin questocasononsigni�ca chenonsianostatirilevati erroridi
corrispondenza,mavuol dire semplicementechenon �e stataprematuramentebloccataa causa
di altri errori,quali peresempiol'impossibilit �adi leggeredeidati.

Ricevuto il messaggiocheriportail successodell'LVS, controllarel'ef fettivacorrisponden-
za clickandosul bottoneOutput della �nestra di �gura 13. Vienemostratocos�� il testoche
riporta i dati e i confronti tra layoute schematico,chemettein evidenzaeventualidifferenze.
Notarechesele dimensionidi untransistorsonodiversenelledueviste,questovienesegnalato,
manonpregiudicai passisuccessivi. In questocasola simulazionedopola BackAnnotation
sar�a effettuataconle dimensioniricavatea partiredal layout.Si raccomandacomunquedi fare
in modochela proceduraLVS nonriporti alcunadiscrepanza.
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3.3.8 Backannotation

La backannotation�e il processotramiteil qualele informazioniestrattedaun layoutvengono
utilizzateperavereunasimulazionepi�u fedeledi un circuito schematico.Infatti i valori delle
capacit�aparassiteedelleresistenzedovuteallageometriadeidispositivi edelleinterconnessioni
non soni noti a livello di schematico,ma devonoesserenecessariamentericavati a partiredal
layout.

L'operazionedi backannotationpu�o esseresvolta in duemodi diversi,chesarannodescritti
nel seguito. Il primo �e molto velocemanontanto�essibile, il secondoun po' pi�u macchinoso
mapermettesimulazionipi�u so�sticate.

Backannotation tramite la vista extracted Questometodoconsentedi utilizzare i da-
ti riguardantile grandezzeparassiteprelevandoli direttamentedalla vista estratta,ed �e molto
semplicedarealizzare.

Dopoessersiassicuratichele celledi cui si vuolefarela simulazionebackannotataabbiano
la vista extracted salvatacorrettamente,richiamarecomedescrittonel paragrafo3.2 il si-
mulatoreAnalog Artist. Procedereesattamentecomenelcasodellasimulazioneconschematici,
con unasolaeccezione:selezionareil comandoSetup -> Environment... e aggiun-
gereall'interno della riga chiamataSwitch View List la parolaextracted prima di
schematic . La simulazionesuccessiva utilizzer�a i parametriparassitiper tutte quellecelle
chesonodotatedi unavistaextracted , esfrutter�a la vistaschematic pertuttele altre.

Questaprocedura,sebbenedecisamentesemplice,haduesvantaggiimportanti:

1. Seduecelle hannoentrambela vista extracted non �e possibilesimularneunacon i
parametriparassitie l'altra senzacontemporaneamente.Questoperch́e Spectre sceglier�a
invariabilmentele visteseguendol'ordine impartitonellaSwitch View List .

2. Nella sceltadellegrandezzedamostraregra�camentenon �e possibileselezionarela cor-
rentein un terminalesela celladi cui il componentefa partepossiedela vistaestratta,e
questa�estataspeci�catanellaSwitch View List .

Unasoluzioneperil punto2 �equelladi portareil terminaledesideratoall'esternodellacellaat-
traversoun pin, selezionandopoi quest'ultimoal livello gerarchicoimmediatamentesuperiore.
Non sempreper�o questa�e unaprocedurasoddisfacente,specieseil componentein questione
nonsi trovaallaperiferiadellacella.

Backannotationtramite la vista analog extracted Questosecondometodorisolveen-
trambi gli svantaggievidenziati nel paragrafoprecedente,ma richiedepi�u tempoper la sua
preparazione.

La backannotationin questacasodeve essereiniziatanonappenaterminaconsuccessola
proceduraLVS. Facendoriferimentoalla �gura 13, clickaresu Build Analog e scegliere
l'opzione

Extracted Parasitics enable all

42



Figura14: Le �nestre New Hierarchy eHierarchy Editor

nella�nestra chevieneproposta.Confermarela scelteconil tastoOKe attendereil messaggio
Done nella �nestra di icfb. La cella di cui si �e fatta l'estrazioneavr�a ora ancheuna vista
chiamataanalog extracted .

L'operazionesuccessiva consistenellacreazionedi un �le di con�gurazioneper il simula-
tore,daassociareallacellaconil livello gerarchicopi�u elevatodallaqualesi vuolefarpartirela
simulazione.Questo�le vieneconsideratoa tutti gli effetti comeunavista,dalnomeconfig ;
perla suacreazione�equindisuf�ciente selezionareNew -> Cellview... dalla�nestra di
icfb o dal Library Manager, e scriverepoi config in View Name. Nel casoin cui la vista
fossestatagi�acreatain precedenza,la si pu�o aprirecomeal solitosenzacrearneun'altra.

Creataquestanuova vista, verr�a propostala �nestra dell'Hierarchy Editor, comemostra-
to in �gura 14. Insiemead essa,se la vista config non esisteva gi�a, verr�a apertaanchela
�nestra New Hierarchy (a sinistranella �gura 14); altrimenti selezionarenel men�u File
il comandoNew. In quest'ultima,all'interno della sezioneTemplate selezionareil simu-
latore spectreS accantoalla voce Built-in ; alcuni dei campi della sezioneGlobal
Bindings si riempionoautomaticamente.Selezionarequindi nella sezioneTop Cell la
cella da cui si vuole far partirela simulazione,avendocuradi indicarela vista schematic
(volendoil tastoBrowse permettedi sceglierlagra�camente).Clickarein�ne suOK.

La �nestra dell'HierarchyEditor conterr�aoral'elencodi tuttele cellepresentinelprogetto,
dispostein unatabellain cui �e indicata,per ognunadi esse,la prima vista esistenteseguen-
do l'ordine datodallaView List . Le celleprogettatemanualmenteavrannoprobabilmente
indicatala vista schematic . L'obiettivo �e quello di selezionare,per le solecelle chesi de-
siderano,la vistaanalog extracted generataattraversoil comandoBuild Analog . Si
pu�o procederein duemodidiversi:
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1. Clickareconil tastodestrodel mousesul nomedellavistanellacolonnaView Found ,
esceglierela vistaopportuna.Oppurescriverneil nomedirettamentenellacolonnaView
To Use. Premeresul tastinoUP(Update)sediventacolorato.

2. Inserireil nomeanalog extracted al primo postonellariga View List e quindi
premereUP (Update)per aggiornarela tabella. In questomodo per tutte le celle che
possiedonola vistaanalog extracted , essaverr�aautomaticamentescelta(salvo poi
scegliereunavistadiversaperalcunedi esse).

Completataquestaoperazioneoccorresalvare la con�gurazionetramite File -> Save e
si pu�o quindi abbandonarel' Hierarchy Editor con File -> Exit , rispondendoYes alla
successivadomanda.

Raggiuntoquestopuntosi pu�o ripeterela simulazione,selezionandotramiteSetup ->
Design... nella�nestradi AnalogEnvironmentla vistaconfig delprogettochesi desidera
simulare. In questomodosi terr�a contoanchedei parametriparassitiestrattie delle effettive
dimensionidei transistoriMOSrealizzati.La proceduradaseguire �edel tuttoanalogaaquanto
gi�a spiegatoper la simulazionedegli schematici,e si rimandaquindi alla sezione3.2. Nella
selezionedelle grandezzedi uscita,scegliere semprela vista schematic ancheper le celle
dellequali esistela vistaanalog extracted ; in questomodo�e possibileancheselezionare
le correntinei terminalidei componentiusati14.

Spesso,e in particolarepercircuiti molto semplici,le capacit�a parassitesonotalmentepic-
colechenonsortisconoeffetti apprezzabilinelleformed'ondarisultanti.Peraccertarsicheil si-
mulatorestiaeffettivamenteutilizzandoi parametriderivantidallabackannotation,nella�nestra
di Analog Environment(vedi �gura 6) selezionarel'opzione Simulation -> Netlist
-> Create Final : seil testocheverr�a mostratoconterr�a dellecapacit�a nonpresentinello
schematico,allorasi pu�o esserecerti chel'operazionedi backannotationhaavutosuccesso.

4 Tecnichedi progettoavanzate

Il progettodi schematicie di layout, cos�� comedescrittonei paragra� precedenti,permette
la speci�ca, simulazionee realizzazionedi circuiti full custom, cio�e espressamenteprogettati
per l'applicazionespeci�ca. Questotipo di approccio,sebbeneforniscain generele migliori
prestazioniperquantoriguardala velocit�a, il consumodi potenzae l'area utilizzatasusilicio,
richiedetempimoltosuperioriperil progettoed �e soggettoaun numeromaggioredi errori.

Perraggiungereun compromessotra prestazionie tempidi svilupposi cercaalloradi riu-
tilizzare al massimolavori gi�a fatti, e di sfruttarealgoritmi di sintesiautomaticaa partireda
descrizioniadalto livello. In quest'otticasi pongonosia il progettotramitecellestandard, sia
le tecnichedi placing e routing automatici. Essendospessoutilizzateinsieme,esseverranno
descrittein questasezioneseguendoi passinecessariperrealizzareuncircuito costituitosiada
cellestandard,siadablocchifull custom.

14Seil terminalenonvienecerchiatodall'ellissenon�edettochela selezionenonabbiaavutosuccesso;veri�care
nella�nestra di Analog EnvironmentnellasezioneOutputs seessocompareo meno.

44



4.1 Progettoconstandard cell

Un circuito logico pu�o esserespessoricondottoadunoschemacostituitodaporte logichepi�u
o menocomplesseinterconnessetra loro. Eseeimplementanofunzioni combinatorieo sequen-
ziali di usomolto comune,e perci�o il lavoro del progettistarisultasempli�cato,ed �e anchepi�u
agevolecapireedanalizzarela funzionalit�adi unsistema.Tuttavia, perottenereil circuito �na-
le occorrecomunquetradurrequestoschemain un layout,realizzandoogni portamediantedei
transistori.Sequestaoperazionevieneeseguitamanualmente,comespiegatonellasezione3.3,
i vantaggiin termini di tempodi progettosi perdono;fortunatamenteesistonometodologiedi
sintesiautomaticacheconsentonodi raggiungererapidamenteil risultatovoluto.

Unastandard cell (cellastandard)�eunbloccogi�aspeci�catoecaratterizzatochesvolgeuna
predeterminatafunzionelogica. Di questobloccosonopresentiin genereun grannumerodi
viste,in particolareil simbolo,il suoschematicointerno,il layout,unadescrizioneadaltolivello
e un modellodelleprestazioni.Esempidi cellestandardsonoi buffer, le portelogicheNAND
eNOR,�ip-�op di vario tipo, multiplexer, etc.. .Le standardcell possonoessererealizzate:

� direttamentedallafonderiao dal fornitoredel DesignKit,

� dal progettistastesso.

In ogni casounacaratteristicacomunedelle celle in una libreria di standardcell �e quelladi
averela medesimadimensionelungounodei dueassi,in modochesiasemplicedisporlein un
chip,semplicementeaccostandole uneallealtre,in lunghesequenzedi righeo colonne.Il par-
ticolaredisegnodel layoutgarantisceinoltre il collegamentoautomaticodi alcunepiste,quali
peresempioquellemetallichedell'alimentazioneedellamassa,comeillustratonellaFigura15.

Essendole standardcell deiblocchigi�apronti,realizzatiperusogeneraleesenzaparticolari
applicazionidedicate,pu�o succedereche nella libreria non si trovi la funzionedi cui si ha
bisogno.�E questoperesempioil casodi unaportaconmolti ingressi,oppuredi unachedebba
pilotarecarichielevati fornendounanotevole quantita'di corrente.In questicasi,o si cercadi
realizzarela stessafunzionecollegandopi�u celle tra loro, o bisognaprogettarneunaspeci�ca.
�E comunqueimportantesaperleggerele caratteristichedellecellestandard,ottenibili attraverso
i loro datasheet;nelcasodelDesignKit AMS, utilizzatonelleesercitazionidi Microelettronica,
vengonoindicateinformazioniquali l'area occupata,i tempi di ritardo in funzionedel carico
capacitivo, la tabelladellaverit�a.

La tabella2 riportaun estrattodellecaratteristichedi alcuneportelogichedi tipo NAND,
conun numerovariabiledi ingressie condiversevelocit�a (indicatein tabellaperun caricodi
0:5 pF).Si notaperesempiocheperandarepi�u velocesi consumaun'areamaggiore,essendo
necessaridei transistoripi�u larghi perottenereunacorrentepi�u alta. A volte ci�o potrebbenon
esserecomunquesuf�ciente, cometestimoniatodallacellaa quattroingressi.

4.1.1 Le standard cell nei circuiti schematici

Per realizzareun circuito schematicoutilizzandole standardcell all'interno dei tool Caden-
cenon �e richiestanessunaparticolareoperazione.�E infatti suf�ciente prelevarledall'apposita
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Figura15: Disposizionein righedi 3 standardcell

Cell Description Ar ea Speed(ns)
(sq.mils) RISE FALL

NA2 2-InputNAND (1x) 0.64 1.25 0.76
NA22 2-InputNAND (2x) 0.86 0.67 0.39
NA3 3-InputNAND (1x) 1.07 1.38 0.81
NA32 3-InputNAND (2x) 1.28 0.82 0.44
NA4 4-InputNAND (1x) 1.28 1.54 0.89
NA42 4-InputNAND (2x) 2.14 1.63 1.10

Tabella2: Caratteristichedi alcunestandardcell
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libreriaeutilizzarlecomesimboli,collegandoletraloroeconle altrecelleeventualmenterealiz-
zateinteramentedall'utente.Essecomparirannonelloschematicoconi loro simboliclassici,gli
ingressie le uscite,masenzapin di alimentazione:essesonogi�a infatti elettricamenteconnesse
ai nodiglobali vdd egnd , tra i quali vapertantofornitaunatensionecontinua.

La libreria checontienele standardcell del DesignKit AMS si chiamaHRDLIB: in essasi
trovano,divisepercategoria,portelogichequali le NAND, NOR, Invertitori, Latch,Flip-Flop,
Multiplexer, . . . . Sonoanchepresenticelleperrealizzarei paddi ingressoedi uscitadell'intero
chip,e percompletarnegli angoli.

Ogni cella contienea suavolta un certonumerodi viste,utili per scopidiversi. Perl'uso
concircuiti schematicile duepi�u interessantisono:

symbol : �e quellada scegliere per realizzarecircuiti schematicicon celle standard.Oltre al
simbolosonopresentii pin peri segnali di ingressoequelli di uscita.

cmossch : �e la vistachecontienelo schemadettagliatodellacella.Percelleelementari,esso
si riduceal solosimbolo,dalqualesi pu�oulteriormentescendereallavistaschematic 15

utilizzandoil comandoDesign -> Hierarchy -> Descend Read... , visua-
lizzandocos�� il circuito a transistori.Percellecomplessesi otterr�a unoschemaformato
dall'interconnessionedi altrecelle.

La vistacmos sch rivesteancheunautile funzionein simulazione:molto spessoinfatti si
realizzaunapartedel progettomanualmente,un'altra tramitestandardcell, magariattraverso
uno strumentodi sintesida descrizionia pi�u alto livello. Perottenereunamaggiorevelocit�a
in simulazionesi preferisceper�o utilizzareinizialmentela vistaextracted per l'operazione
di Backannotation(vedi paragrafo3.3.8) solo per i blocchi full custom,mantenendola vi-
staschematicaper le celle standard16. Perottenerequestosi pu�o comodamenteutilizzare la
Switch View List , visualizzabilecon il comandoSetup -> Environment... di
Analog Artist, inserendola sequenza:

Switch View List: spectreS cmos_sch extracted schematic

In questomodole standardcell verrannosimulatesoloapartiredaquantocontenutonellavista
schematica.Sesi voglionobackannotareanchequesteultime,occorrerealizzareil layout(come
descrittonel paragrafo4.1.2o nella sezione4.2) dellacella a livello gerarchicosuperioreche
le contiene,estrarnei parametriparassiticreandola vistaextracted , equindi risimularecon
gli stessiparametriprecedenti.

4.1.2 Le standard cell nel layout manuale

Sebbenel'uso delle standardcell sia quasisempreaccoppiatoa tecnichedi generazioneau-
tomaticadel layout,per completezzavienequi descrittoun modoperpoterleutilizzareanche
manualmente.In questocasola metodologianon si discostamolto da quantodescrittonella

15Notarechela vistaschematic dellecellestandard�eaccessibilesolodallavistacmos sch dellamedesima,
e nondirettamenteconil Library Manager.

16Notaretra l'altro chenonesistela vistaextracted perle standardcell.
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sezione3.3,conla differenzacheil layoutdi ogni cellapu�o essereprelevatodirettamentedalla
libreria.

Unavolta apertala vista layout dellacellacontenentele standardcell, occorreinvocare
il comandoCreate -> Instance... , attivabileancheconla pressionedel tastoi o con
l'appositaiconapostasul lato sinistrodella �nestra. Comaparir�a una�nestra chiamataCreate
Instance, simileaquellagi�anotaperl'inserimentodi componentidi libreria in unoschematico,
sulla quale �e possibilespeci�careil nomedella libreria, della cella e della vista chesi vuole
inserirenel layout,oppureselezionarlapremendoil bottoneBrowse . Nel casodellestandard
cell, la libreria corrispondealla HRDLIB, la cella �e quellachesi vuole inserire,e la vistadeve
esserelayout . Spostandoil cursoredel mousesulla �nestra di layout comparir�a a questo
puntoil contornodellacella,cheverr�acreatasemplicementepremendoil tastosinistro.

Il progettodel layout cos�� ottenutosar�a di tipo gerarchico,in cui celle , ancherealizzate
manualmentedal progettista,possonoessereriutilizzate a livelli pi�u alti, anchepi�u volte. In
certi casinon verr�a visualizzatoil layout di tutte le celle, ma solo il loro contornoe il nome;
in questicasi,sesi desideravisualizzarneil contenuto,selezionareil comandoDesign ->
Options -> Display... eaumentareil numeronel campoTo delparametroDisplay
Levels �no al valoredesiderato.

Il layoutdellastandardcell, essendoprelevatodaunalibreria, nonpu�o esseremodi�cato.
�E per�o possibileaggiungeredellemascheredisegnandolemanualmentesopraalla cella,con il
risultatodi alterarnele caratteristiche.Peraltro, questaoperazione�e assolutamentenecessaria
percollegaremanualmentele variecelle,partendodaipin solitamenterealizzaticonlamaschera
Metal2 per quantoriguardagli ingressie le uscite,e in Metal1 per l'alimentazionee le
masse.

4.2 Place& Routeautomatici

Percircuiti di piccolissimedimensioni(alcuneportenel casodi sistemidigitali, qualchede-
cinadi transistorperquelli analogici)�e relativamentesempliceprogettarela disposizionee le
connessioniin mododa ottimizzarel'utilizzo dell'areasul chip. Perdimensionimaggiorisi
presentanoinvecedei problemi,chediventanopraticamenteinsormontabilipercircuiti di tipo
VLSI. Fortunatamentegli strumentiCAD mettonoadisposizionedegli algoritmi pereffettuare
questaoperazionein modosemiautomatico,conscelteguidatedall'utente.

Il �usso di progettocompletoperun progettomisto full custom– standardcell �e mostrato
in Figura16. I primi duepassisonogi�a stati descrittinei dettagli,mentrein questasezione
verrannoaffrontati in sequenzagli altri quattro.In sintesi,il �usso di progetto�e il seguente:

progettoschematico : in questafaseil progettistadisegnail circuitoutilizzandocomponentidi
libreria,chepossonoesseretransistori,elementipassivi, standardcell, etc.. . . Il progetto
�e diviso in celle gerarchiche.A questolivello si pu�o effettuareunaprima simulazione
senzai parametriparassiti.

layout cellefull custom : per le celle chenon contengonostandardcell, il progettistadise-
gnaancheil layout manualmente,e pu�o estrarrei parametriparassitiper eseguire una
simulazionepi�u accurata.
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Figura16: Flussodi progettocontecnichedi Place& Route

abstract view cellecustom : i successivi passidi progettonecessitanodi alcuneinformazioni
particolarisullecelle checompongonoil circuito. In particolare,perogni cella occorre
conoscerele suedimensioni(perpiazzarlacorrettamentesul chip) e la posizionedei pin
di interfacciaconle altrecelle(perpoterlacollegareadaltrecelle). Questeinformazioni
sonocontenutein unavistachiamataabstract : le standardcell nesonoin generegi�a
provviste,mentreperle cellerealizzatemanualmenteoccorregenerarla.

�oor planning : questafaseprevedeun intervento manualedel progettista,che de�nisce le
zonesul chip chesarannodedicateai blocchi full custom(piazzatimanualmente),alle
standardcell e ai pin di ingresso/uscita.In questafasepossonoancheesserede�niti dei
gruppidi blocchichedevonoesseremantenutivicini.

placing : in questopasso,ormaide�nita l'organizzazionegeneraledel chip,vengonopiazzate
in modo automaticole standardcell all'interno delle regioni appositamentecreateper
loro. L'interventomanuale�edecisamenteridotto.

routing : il layout del chip vienecompletamentedeterminatoeffettuandoi collegamentitra
i vari blocchi. �E possibileeseguire questocompito in modo interamenteautomatico,
oppureinteragirecon il tool, in particolareper quantoriguardail collegamentodelle
alimentazioniedellemasseai pad.

4.2.1 Creazionedella vista abstract

Perpotercorrettamentepiazzareecollegarele cellein modoautomaticonon�enecessariocono-
scereil layoutin mododettagliato:�e infatti suf�ciente un insiemedi informazionipi�u ristretto,
in partericavabili direttamentedal layout stesso,in parteforniti dal progettista. Questein-
formazionivengonomemorizzatein unaparticolarevista,chiamataabstract , cheverr�a poi
utilizzatanelrestodel �usso di progetto�no praticamentealla�ne, quandoverr�asostituitadalla
vistalayout corrispondente.

Le informazioninecessariecontenuteall'interno dellavistaabstract sonoin sintesi:

� le dimensionidellecella, in generenella formadi rettangolocircoscritto,chesonorica-
vatein modoautomaticoapartiredal layout;
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Figura17: Direzionidi accessoai pin

� la posizionee la mascherautilizzataper i pin di comunicazione,anch'essericavabili in
modoautomatico;

� le direzionidi accessoconsentiteperognipin, daspeci�carea curadel progettista.

L'ultimo punto �e particolarmenteimportante:l'utente deve veri�care da quali direzioni (alto,
basso,sinistrae destra)pu�o arrivareunapistarealizzatacon la mascheradel pin, senzainter-
secarealtrepistedellamedesimamascherae senzaviolarele regoledi progetto.Un esempio�e
illustratoin �gura 17,dovesonopresentidueingressi,chiamatiA eB, edueusciteQ eQ. Nella
�gura sonorappresentatele solepistein Metal2 , conla qualesi supponesianostatirealizzati
tutti equattroi pin. In questocasoquindi le direzionidi accessopossibilisaranno:

A : l'unica direzionepossibile�e dasinistra. Dall'alto nonsi intersecanessunaaltrapista,
masi violerebbeunaregoladi progettoperch́esi passerebbetroppovicini adun'altra.

B : l'accesso�econsentitosolodasinistraedalbasso,essendole altredirezionituttecoperte.

Q : in questocasol'unico modoperraggiungereil pin �edall'alto o dal basso.

Q : perquest'ultimopin le pistepotrannogiungereesclusivamentedall'alto o dadestra.

Tuttelestandardcell forniteconil DesignKit AMS gi�adispongonodi unavistaabstract ;
�e quindi necessariogenerarlasolo per le celle full customdel progetto.Si inizia caricandola
vista layout della cella, e selezionandoil comandoTools -> Abstract ; serichiesto,
selezionareancheCE/BE, per indicarechesi desiderautilizzareCell Ensemble/Block Ensem-
ble comerouterautomatico.Comparir�a un nuovo men�u, chiamatoAbstract , nellabarrain
alto.

50



La successiva operazioneconsistenel de�nire le propriet�a di tutti i pin. Se questinon
esistono,crearli con il comandoCreate -> Pin... , seguendole notegi�a indicatenella
sezione3.3. Quindi selezionarliuno per uno, e invocareil comandoAbstract -> Set
Pin Props... : nella �nestra cheapparir�a veri�care le direzionidi accesso,il tipo del ter-
minale (input, output, . . . ) e il tipo del segnale. Per i pin di alimentazionee massaoccorre
cheTerminal Direction siaimpostatoa inputOutput e Signal Type a supply .
Confermarele eventualimodi�che clickandosul tastoOK.

Terminatele modi�che relativeai pin, occorrede�nire le dimensionidellacella. Il passo�e
del tutto automaticoe si ottienetramiteil comandoAbstract -> Auto Boundary , che
creaunrettangolointornoallacella.Successivamentesi devegenerarelaveravistaabstract ,
selezionandoAbstract -> Abgen... , econtrollandochenellasuccessiva�nestra il cam-
po Rules Library sia impostatoa TECHCYE, e non al valore di default che in genere
corrispondeal nomedellalibreriacui appartienela cella.

Setutto procedecorrettamente,la vista abstract viene�nalmente creata;�e necessario
per�o ancoraun passo,e per questooccorreaprirla. Per farlo, utilizzare il Library Manager,
oppuredalla�nestra di layoutselezionareDesign -> Load esceglierela vistaabstract
appenacreata.Comparir�a un layoutprivatoquasidi tutto, fattaeccezioneper le maschereche
costituisconoi pin e per il contornogeneratoin precedenza.Un esempio�e mostratonella�gu-
ra 18,dove �e statacaricatala vistaabstract di unacellastandard(unaNAND a 4 ingressi).
L'ultima operazioneprevedela de�nizione delle propriet�a dell'intera cella, e si ottienecon il
comandoAbstract -> Set Cell Props... : il tipo della cella (Cell Type ) deve
esseremacro , e la classe(Cell Class ) deve essereblock . Veri�care inoltre cheper i
parametrimodi�cati siaattivato il tastinopostosullasinistradel valore. Confermarequindi le
modi�che clickandosuOKesalvarela vistaconil comandoDesign -> Save .

4.2.2 Floorplanning

Tutte le operazioni�n quaesaminateeranovolte al progettoschematicodi un interocircuito,
attraversol'interconnessionedi cellein uncomplessogerarchico,eallarealizzazionedel layout
dellesingolecelle. Il layoutcompleto,ottenutoattraversol'assemblaggiodel layoutdellevarie
cellesuun singolochip,pu�o essereeffettuataconmodalit�adifferenti:

Top-down : si partedal livello gerarchicopi�u alto, si stimanole dimensionidellecellechelo
compongonoela posizionedeipin, e le si piazzanosulchipcollegandoletra loro. Quindi
si scendeall'interno delle celle, e per ognunadi essesi ripete l'operazione. Una volta
giunti al livello pi�u basso,in luogo delle stimesi possonousarei dati veri provenienti
dallevisteabstract , equindisi pu�o tornaresunellagerarchiaraf�nando le sceltefatte
in precedenzabasatesolosustime.

Bottom-Up : si partedal livello gerarchicopi�u basso(le celle elementari),piazzandotutti
i componentie collegandoliai pin di interfacciacon le altre celle. Si salequindi nel-
la gerarchia,utilizzandoquantofatto in precedenzacomeblocchi elementari,di cui si
conosconogi�a le dimensionie la posizionedeipin.
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Figura18: La vistaabstract di unacellaNAND a4 ingressi

Flat : tutto il layoutvienecostruitoin unaunicasoluzione,apartiredallesingolecelleelemen-
tari chelo compongono,senzaconsiderarela gerarchialogicadel progetto.

In questatrattazioneci occuperemoquasiesclusivamentedellametodologiaFlat,pi�u semplice
daeseguireperch́e richiedemenopassi.La Top-down presentalo svantaggioinfatti di doversi
basareinizialmentesustime,e di richiederequindi delle leggeremodi�che in baseai risultati
reali dei passisuccessivi; essaper�o hail grossovantaggiodi poterottimizzarein modoglobale
laposizionedeipin. La Bottom-Up�epi�usimileallaFlat,maperalcuniblocchivengonoeseguiti
il placing e il routingsingolarmente,e vengonopoi utilizzati comeelementisingoli al livello
superiore.

Il primopassovienechiamatoFloorplanning, econsistenelloscegliereapprossimativamen-
te le dimensione�nali del chip, nel piazzaremanualmentei blocchiprogettatiin manierafull
custome nel de�nire le regioni, chesonodelle entit�a astrattedi cui si speci�canola posizio-
ne e le dimensionie in cui sarannopiazzateautomaticamentele standardcell. Essesaranno
dispostein unao pi�u righe (il numero�e sceltodal progettista)separateda zonededicatealle
interconnessioni.

Generazionedella vista autoLayout

Percominciarela proceduradi sintesidel layoutcompletooccorrepartiredallavistaschematica
a livello gerarchicopi�u elevato,cheescludaper�o le sorgentie i carichiesternicheovviamente
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Figura19: L' HierarchyBrowserconi livelli gerarchiciespansi

non dovrannoessereimplementatisul chip. Da questaautomaticamentesi pu�o generareuna
vista,chiamataautoLayout , cheverr�a utilizzatanei successivi passidi placee di route. La
vistaautoLayout �e daconsiderarecomunqueunavistadi lavoro,e potr�a esserericreatapi�u
volte se si �e nella necessit�a di ricominciareil lavoro o per provarealtre soluzioni. Durante
l'intera procedurasar�a comunqueconvenientesalvarei risultati intermediin altre viste, il cui
nomepu�o esseresceltodall'utente.

Dalla �nestra schematicadel livello gerarchicopi�u alto selezionareTools -> Floor-
plan/Schematics . Compareunnuovo men�u nellabarrain alto,chiamatoFloorplan ; da
essoselezionareHierarchy Browser... , veri�care chenella�nestra successivasiaindi-
catoil nomedellacellaelavistacorrette,quindipremereOK. Comparela �nestradell'Hierarchy
Broswer, nelquale�erappresentatal'intera gerarchiadelprogettosottoformadi unalbero17, co-
memostratonella�gura 19. Perla proceduradi tipo Flat, selezionarela cellaradice(senonsi
sonodatialtri comandi�e l'unica cellarappresentata)chedaverdediventarossa,quindiselezio-
nareHierarchy -> Generate Physical Hierarchy esenecessarioconfermarela
sovrascritturadi unaeventualevistaautoLayout gi�apresente.Il comandoeseguir�aunaprima
stimadell'areanecessariaperl'intero sistemaequindicreer�a la vistaautoLayout (veri�care
la presenzadi messaggidi errorenella�nestra di icfb18).

A questopuntosi pu�o chiuderel' HierarchyBrowsereaprirela vistaautoLayout appena
sintetizzata.In essasarannovisibili tutti i blocchichecostituisconoil circuito, i pin del livello
gerarchicopi�u alto (o i pad,sesonostatiutilizzati) e il contornodelchip, inizialmentequadrato
e conun'areaottenutadaunastimadi quellachesar�a necessaria.Da questa�nestra, invocare
il comandoTools -> Floorplan/P&R -> Cell Ensemble , checauser�a l'apparire
di nuovi men�u nella barra,e di unanuova �nestra chiamataObjectSelectionWindow (OSW),
mostratanella�gura 20sullasinistra.La �nestra OSW�esimilecomefunzionalit�aallaLSWpre-
sentatanel paragrafo3.3.2a propositodel progettomanualedel layout;essaper�o nonriguarda

17Pervederlacompletamenteoccorreespanderei livelli, altrimentivienemostratosoloil primo.
18La stessafunzionesi ottieneselezionandoil comandoFile -> Export -> PRFlatten... dalla

�nestra di icfb, riempiendoopportunamentei campi vuoti della �nestra di dialogo che viene successivamente
proposta.
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Figura20: La vistaautoLayout e la ObjectSelectionWindow.

le mascheredel processo,mabens�� elementipi�u astrattiquali i blocchi(instance), chepossono
esseresia full custom,siastandardcell, le regioni, i collegamenti,i pin, etc. Quandounacer-
ta tipologia vieneevidenziataall'interno della �nestra OSWclickandocon il tastosinistrodel
mouse,tutti gli oggettiappartenentiadessasarannoselezionabiliedeventualmentemodi�cabili
nellavistaautoLayout corrispondente.

Floorplanning sulla vista autoLayout

La prima operazioneda eseguire sulla vista autoLayout consistenella suainizializzazio-
ne:selezionareaquestoscopoFloorplan -> Reinitialize... rispondendoOKnella
successiva�nestra; lo stessocomandodeveessereinvocatosesi vuoleripeteretuttodall'inizio,
perdendoquantosi stava facendoa menodi nonrichiederespeci�catamente,tra i parametridi
inizializzazione,il mantenimentodi certesceltegi�a eseguite. Comemostratonell �gura 20,
verr�apostoil chipvuotoal centro,sullasinistracomparirannoi blocchifull custom,sulladestra
le standardcell, e in�ne in alto i pin o i pad.All'interno delchipsar�a inoltrevisibile, caratteriz-
zatadaun contornoblu, unaregionechevienecreatadi default percontenerele standardcell;
essapotr�aesseremodi�cata (o addiritturacancellata)successivamente.

I pin di ingresso/uscitasonoi primi da piazzare,in modo automaticoo seguendole in-
dicazionicontenutein un �le da compilarea curadell'utente. Quest'ultimaopzione�e parti-
colarmenteutile nel casodi chip misti analogico/digitali,poich́e i padpossonoesseredi tipo
differenteed �e convenienteraggrupparlivicini perfacilitarei collegamenti.Peril piazzamento
automatico,selezionareFloorplan -> I/O Place... , quindiconfermarele sceltepro-
posteclickandosuOKnella�nestra chesi sar�aaperta.I pin (o i pad)vengonoautomaticamente
distribuiti nellaperiferiadel contorno,chevieneancheleggermenteingranditoin basealla mi-
nimadistanzaspeci�catatra i pin stessie il core, cio�e la partedel chip dedicataai circuiti veri
epropri.

Quindi �e la volta dei blocchi full custom:dopoessersiassicuraticheil campoInstance
sia evidenziatonella �nestra OSW, spostaremanualmentei blocchi all'interno del chip con il
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mouse,posizionandolinella locazionedesiderata.Sesi utilizza il comandoMove, attivabile
dal men�u Edit o tramiteil tastom, e sedurantel'operazionesi premeil tastoF3, si accede
ad una�nestra con la quale�e anchepossibileruotareo specchiareil blocco. In questafasei
blocchipossonoanchesovrapporsiparzialmenteo completamentealle regioni.

L'ultima fasedel �oorplanning riguardala de�nizione dei parametridelleregioni. Perpro-
getti piccoli �e in generesuf�ciente de�nire unasingolaregione(quelladi default); perprogetti
pi�u complessi�e inveceutile avereun numeromaggioredi regioni, in mododaraggrupparele
standardcell in basealla funzioneparticolaresvolta. Permodi�care i parametridi unaregio-
neoccorreselezionarla(nella �nestra OSWla voceRegion deve essereevidenziata),e quindi
invocareil comandoEdit -> Region... : sar�a quindi possibilespeci�careil numerodi
righe desideratee la direzione,orizzontaleo verticale,di riempimento. Clickandosul tasto
Update Region verr�a mostratogra�camentel'ef fetto delle modi�che, e sar�a anchevisua-
lizzatola percentualeeffettivaoccupatadallestandardcell: essadeveessereinferioreal 100%;
semaggiore,signi�ca chela regione �e troppopiccolae va ingrandita.Primadi confermarele
modi�che clickandosuOK, l'utentepu�o quindiancoradecideresecambiarele dimensionidella
regionee/ospostarnela posizioneall'interno delchip.

4.2.3 Placingautomaticodellestandard cell

Giunti a questopuntodel �usso di progettotutti i blocchifull custome i pin di ingresso/uscita
sonogi�a stati piazzati; rimangonoquindi solamentele celle standard,dopo le quali si potr�a
procedereconla realizzazionedelleconnessioni.

Le standardcell vengonosemprepiazzatein manieracompletamenteautomatica.�E infatti
suf�ciente invocareil comandoPlace -> Automatic... e riempirecondati opportuni
la successiva �nestra di dialogo. In essaoccorrespeci�caresesi desiderainseriredelle celle
Feedthru, cio�e dellespecialicellecompletamentevuote(eccettole duelineedi alimentazione
e massa)attraversocui possonopassarei collegamenti. Esseovviamenteoccupanoareache
nonpu�o essereutilizzataperareeattive,mafacilitanoil routing. Perprogettipiccoli nonsono
necessarie,altrimenti occorreselezionarel'opzione Insert Feedthru e quindi compilare
la mascheracherichiedeil nomedella libreria (HRDLIB), il nomedellacella master(FEED)
e la vista (abstract ). In ogni casooccorrespeci�care il parametroPlacement Snap
Grid , che deve esserepari alla larghezzadella cella pi�u strettadella libreria; nel casodel
processoAMS utilizzatonelleesercitazionidi Microelettronicaessavale3:0�m (nelparametro
nonbisognospeci�carel'unit �adi misura).Clickarequindi suOKperdareil via alla procedura
automatica,al terminedellaqualetuttele standardcell sarannopiazzatenellerispettiveregioni.
Sepossibile,il sistemavieneanchecompattatoriducendole distanzedalcontornodelchip.

In molti casi �e utile aggiungereall'interno e ai bordi dellerigheappenacreatedellePower
Cell, cio�ecelle�ttizie utili perla successiva fasedi collegamentodellelineedi alimentazionee
massa.Perfarlo,selezionarePlace -> Power Cell -> Add Auto... : occorrequin-
di speci�careesattamentequali celle inserire,riempiendoi campidelle�nestre comemostrato
nellaFigura21 (la �nestra di destrasi ottieneclickandosuPre-Define Power Cells ).
�E possibiledecidereseinserirele cellesoloall'interno,soloadestra,soloasinistra,oppureuna
combinazionedi esse;nel casoparticolaremostrato,soloquelleinternee a sinistrasonostate
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Figura21: Finestraperl'inserimentodellePower Cell .

scelte19. Clickarequindi suOKe veri�care chenonci sianoerrori. Percircuiti piccoli comun-
que�esconsigliabileseguirequestaprocedurain quantononci sonoin ogni casoproblemiperi
collegamenti.

Sela cella schematicada cui si �e partiti �e anchequellaa livello gerarchicopi�u elevato di
tutto il chip, e quindi contienei pad(noni pin) nellaperiferia,occorrea questopuntoaggiun-
gereanchele celleangolari.Anchequestaoperazione�e totalmenteautomaticae si ottienecon
Place -> IO Commands -> Add Corners... scegliendopoi HRDLIB – CORNERP
– abstract comelibreria, cellae vista rispettivamentedellaGlue Cell . Premerequindi
sulbottoneOK.

Primadi procedereconla realizzazioneautomaticadeicollegamenticonvieneveri�care che
tutte le standardcell sianoeffettivamenteall'interno della regionedi competenza.Perfarlo �e
suf�ciente aumentarel'ingrandimentoin mododavisualizzarebene,unoalla volta, gli angoli
della regione. Qualorauna cella fosseancheparzialmenteal di fuori, assicurarsiche nella
�nestra OSWsiaselezionatala voceRegion , quindi allargarela regioneutilizzandoil mouse
(posizionandoil cursoresuunbordoessocambiaforma,epremendoil tastosinistro�epossibile
modi�care le dimensionidella regione),selezionaresuccessivamentetutte le standardcell al
suointerno,e dareil comandoPlace -> Snap to Grid... : nellasuccessiva �nestra di
dialogo,selezionareSelected Cells e veri�care il valoredellagriglia.

Un'altra operazioneconsigliabile�e giusti�care i pin della periferia: con essavengonoal-
lineati tra loro i pin (o i pad)e vieneaggiuntoun certospazio,utile per le fasi successive, tra
la periferiae il circuito al centro(il core). Questaprocedura�e estremamenteimportanteper la
creazionedei canali(vedi paragrafo4.2.4),nei quali sarannopoi fatti passarei collegamenti.
Senonsi sonoprimagiusti�cati i pin, successivamentein alcuni casiinfatti pu�o succederedi
ricevereunmessaggiodi errorenella�nestra di icfb chedice:

Design is not sliceable

Ci�o signi�ca chenon �estatopossibiletrovarespazioasuf�cienza perdividerele variezonedel
progettoefarpassarei canali.Questoerrorepu�o ancheveri�carsi nellaprecedenteproceduradi

19Ci�o �e dovuto al fattochenellatecnologiausataperquestoesempiononsonodisponibili le Power Cell di
destra,chealtrimentisi chiamarebberoRCAP.
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Figura22: La vistaautoLayout terminatal'operazionedi Placeautomatico

inserimentodellePowerCell. Giusti�care la periferia�ecomunqueestremamentesemplice:ba-
stainvocareil comandoPlace -> IO Commands -> Justify , speci�candol'origine
(origin ) comeAlign Feature edelleopportunedimensioniperla spaziaturatraperiferia
e core(qualchedecinadi micronperprogettipiccoli, �no a qualchecentinaioperquelli gran-
di). Inoltre fornire un valorepiccolo,peresempio0.1,per la griglia utilizzatapergiusti�care.
ClickandosuOKsi avvia la procedura,chein genereterminain pocotempo.

Giunti a questopuntosi dovrebbeottenereun autoLayout simile a quello mostratoin
Figure22, dove non si �e fatto usodi padma solo di pin di ingresso/uscita.Convieneanche
salvareil lavoro �no a qui svolto, con il comandoDesign -> Save As... e scegliendo
un nomeapropriopiacimentoperla vista,peresempioplaced .

4.2.4 Routing automatico

L'ultimo passoperottenereil layoutcompletodel chip o dellacellacomplessachesi stapro-
gettando�e la realizzazioneautomaticadelleconnessioni.Questaoperazionesi ottineattraverso
l'esecuzionedi unaprocedurache,per gradi, costruiscele necessariepistemetallicheavendo
comeguida i nomi dei pin e i collegamentipresentinelle viste schematichedelle varie cel-
le. In questasezioneverrannoanalizzatii vari passinecessariper completarecon successo
l'operazione.

Creazionedei canali e propriet �a delleconnessioni

Tutte le connessionicreate,sia in modo automaticosia con l'aiuto del progettista(in modo
interattivo), occuperannodelle zonedel chip a loro espressamentededicate,cheprendonoil
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nomedi canali(channel). Il programma�e in gradodi identi�care autonomamentequestezone,
ammessochesiapossibiletrovarnein numeroe in posizionesuf�cienti per tutti i collegamen-
te da realizzare. Af�nch é ci�o sia possibile,il progettodeve poter esseresuddiviso (sliced)
opportunamente.

Per crearei canali selezionareil comandoRoute -> Channels -> Create... ,
quindi confermarecon OKle opzioni chevengonoproposte.Senon ci sonoproblemi,delle
nuove celle comparirannonella vista autoLayout , aventi per nomequello della della cel-
la schematicaapertainizialmente,seguita da Channels pi�u unasigla identi�cativa di ogni
canale.Seinvecesi riceve un messaggiodi errore,giusti�care la periferiacomedescrittonel
paragrafo4.2.3,oppureripetereil placingdellestandardcell, cercandodi aumentarelo spazio
traunarigae l'altra (peresempioaumentandola dimensionedellaregione).

Successivamenteconvienemodi�care le propriet�a di alcunicollegamenti(net), utilizzando
il comandoRoute -> Modify Net -> Modify Net Properties... e riempien-
do opportunamentei campiproposti,avendol'accortezzadi clickaresul bottoncinopostoalla
sinistradi quelli modi�cati. La modi�ca delle propriet�a �e particolarmenteimportanteper le
alimentazionie le masse,chehannobisognodi condizionidiversedai segnali normali. Nel
dettaglio,le propriet�asono:

Net Names : possonoessereelencatidiversi nomi, e se alcunenet eranogi�a selezionateal
momentodell'invocazionedel comando,esserecomparirannoautomaticamente20. Le
alimentazionie le massein generesi identi�cano con i nomi vdd! e gnd! ; nei pad,
esseprendonoi nomi di PVDDR1!, PVDDR2!, PVSSR1!, PVSSR2!, PVSSR3! e
PVSSR4!.

Priority : ad ogni collegamentovieneassegnataunapriorit�a tra 0 e 127; maggiore�e questo
valore,prima verr�a consideratala net nella creazioneautomaticadei collegamenti. Per
valori superioria 10 vienesuccessivamenteutilizzatoil routeradalberoinvecedi quello
normale. Per le alimentazionie massenei pad,si consigliaunavalorepari a 120, per
vdd! e gnd! pu�o bastare115. Ancheil segnaledi clock deve avereunapriorit�a molto
alta. Pertutti gli altri segnali va beneil veloredi default (quindi nonoccorrecambiarlo),
che�esempreinferiorea10.

Width : �e la larghezzapreferenzialein micron(nonoccorrecio�e speci�carel'unit �adi misura)
dellepistecheverrannocreateper il collegamento.Sesi inserisceun valoreinferiorea
quellominimo delleregoledi progetto,essoverr�a ignorato.Pervdd! e gnd! conviene
speci�careunvalorealto,peresempio15.

Spacing : �e la minimadistanza(in micron)tra le piste.Seil valoreinseritoviola unaregoladi
progetto,essosar�a ignorato.Senonci sonoparticolariproblemi,�e inutile modi�carlo.

Type : pu�o assumerei valori signal , supply , ground , clock e unassigned . Il tool

20Perselezionareunanet,selezionaresiaNet cheInstance nella�nestra OSW, quindi selezionareunacella
cui la net �e collegata,deselezionareInstance in OSW, quindi invocareil comandoEdit -> Select ->
Connected To. Quindi deselezionarequellechenoninteressano.
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dovrebbericonoscerein automaticole alimentazioni,mentre �e importantespeci�care
questoparametroperil segnaledi clock.

Status : indicalo statodellanet,cio�e seperessa�e gi�a statoeseguito il routeglobaleo quello
dettagliato.In generenon �enecessariomodi�carla.

Layer : �e la mascheradausarepreferenzialmenteper realizzarele pistedi collegamento.Se
nonsi speci�caniente,il programmadecider�a in modoautomatico.

Fix Net Global Route Topology : sevengonoeseguiti pi�u routeglobali in successione,ma-
gari su net differenti, questoparametro,se selezionato,speci�ca che la topologiadel
collegamentonondeveesserecambiata.Perle alimentazionie le masseconvienesempre
selezionarlo.

Clickarequindi su OKper confermarele scelte. Sel'operazionedeve essereripetutadiverse
volteperlo stessoprogetto(peresempioperch́esi intendeprovarediversesoluzionidi placing)
conviene la prima volta salvaresu �le le propriet�a e quindi rileggerlein un secondotempo.
Utilizzare a questoscopoil comandoRoute -> Modify Net -> Net Properties
File... .

Le connessionidi alimentazionee massadellacellaa livello gerarchicopi�u alto contenen-
te i pad necessitanodi una ulteriore operazione,che si ottienecon il comandoRoute ->
Modify Net -> Split Net . La connessionelogicavienedivisain duenetseparate,una
per i paddella periferia(cui vieneaggiuntanel nomela stringaRing ), unaper il core(con
l'aggiuntadi Int ), dove �e presenteil circuito. Ci�o �e necessarioperch́e verrannoutilizzatedue
tecnichediverseperla fasedi routing.Attenzionechequestamodi�ca causer�a dei messaggidi
erroreseil layoutchesar�ageneratoverr�aconfrontatoconlo schematico.

Global routing

In questafaseogni connessionevieneassegnataadunoo pi�u canalitraquelli precedentemente
creati.La pistaverae proprianonvieneper�o ancorarealizzata,rimandandoquestocompitoal
passosuccessivo di routingdettagliato.

�E possibileseguireduestradedifferenti,unacompletamenteautomatica,l'altra cherichiede
uninterventomanuale.Le duepossonoancheessereutilizzatecontemporaneamente,peresem-
pio usandoquellamanualeper le lineedi alimentazionee massa,e quellaautomaticaper tutte
le altre.

Global routing interatti vo Questamodalit�a �econsigliataperi collegamentidellealimen-
tazionie dellemassedai padai circuiti presentinel coredel chip, e deve precederequalunque
passodi routeglobaleautomatico.Per invocarla,selezionareRoute -> Global Route
-> Interactive Global Route... ; comparir�a un men�u sotto forma di �nestra me-
dianteil qualesi possonoeseguire,perogni netchesi vuolecollegaremanualmente,i seguenti
passi:
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Figura23: InteractiveGlobalRoutedellalineadi massa

1. Clickare su Initialize Net , introdurre il nomedella linea (per esempiovdd! ),
quindi clickaresu OK. Sulla �nestra dell'autoLayout i pin di alcunecelle vengono
evidenziaticonun triangologiallo, e sul bordodei canalicompaionodei rombi. Questi
elementivengonochiamatiSnapPoint.

2. Senecessario,clickaresu Settings... e aumentareil valoredi Scale Factor
(peresempioa5) perotteneretriangoli e rombidi dimensionimaggiori.

3. Selezionare,mantenendopremutoil tastoShift , il pade i pin chesi voglionocollegare.
Sesi deve attraversareun canale,selezionareancheil romborelativo. Tutti gli elementi
selezionatiassumonoil colorebianco.

4. Clickare su Connect Set . Sulla �nestra dell'autoLayout compaionole linee di
connessione,comemostratonella�gura 23.

5. ClickaresuExit Net... , quindi selezionarel'opzioneFix Net Global Route
Topology e clickaresu OK. Sesonostati selezionatitutti i pin necessari,appareuna
�nestra checomunicachelo statodellanet �e statomodi�cato in edgeConnected . In
altri casiil messaggiosar�adifferente,perch́enontutti i pin sonostatiselezionatiequindi
partedellanetnon �e stataconnessa;sesi desideraprocederelo stesso,clickaresuOKe
�ssarelo statodellanetaedgeConnected tramitela �nestra successiva.

Ripeterela proceduraquantevolte si vuole,quindi clickaresuDONEperuscire. Utilizzare la
proceduraautomaticasealcunelineedevonoancoraesserecollegate.

Global routing automatico Questaoperazione�e estramentesemplicee spesso�e an-
che l'unica da seguire. �E infatti suf�ciente selezionareRoute -> Global Route ->
Automatic e quindi clickaresu OKper confermarei parametridi default nella �nestra che
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vieneproposta.Attenderequindi l'esecuzionedellaproceduraeveri�care l'eventualepresenza
di errori nella�nestra di icfb.

Detailed routing ecreazionedel layout �nale

L'ultima operazionerimastaconsistenel realizzarele vereepropriepistein metalloperle con-
nessionie comprimereil circuito totaleottenutoin mododa occuparele dimensioniminime.
Essa�e interamentegestitain modoautomatico,attraversoil comandoRoute -> Detail
Route -> Automatic... , ma occorremodi�care alcuneopzioni: nella �nestra di dia-
logo clickare sul bottoneCompact , introdurreil valore 0:05 in Routing Snap Grid e
selezionareto instance blockages perpermettereai bordi dei canalidi estendersian-
chedentrole altrecelledurantela compressionedel layout. ConfermareconOKquestescelte,
quindi avviarela proceduraclickandosul tastoOKdella�nestra iniziale. Osservarei messaggi
sulla�nestra di icfb perveri�care eventualeerrori eattenderela conclusione.

La proceduradi Place& Route �e ora terminata. Per visualizzarele linee di connessio-
ne aumentareil numerodi livelli gerarchicivisualizzatiattraversoil comandoDesign ->
Options -> Display... nel campoDisplay Levels . Ci si render�a in questomodo
conto del lavoro svolto, e anchedel fatto che tutte le celle sonoancorapresenticon la sola
vista abstract . Perottenereil layout vero occorresostituirla: scegliere Floorplan ->
Replace View... , clickaresulbottoncinopostovicino aall (in questomodotuttele cel-
le sarannoaggiornate)e impostarela vistalayout nel campoTo View Name. Clickaresu
OK. La �gura 24 mostraun esempiodi circuito �nale, contenentei pade un piccolo circuito
realizzatoconstandardcell.

Il layout �e quindi prontoper essereveri�cato attraversole tecnichedescrittenel paragra-
fo 3.3.5e successivi. Peraccedereai men�u relativi �e ancoranecessarioselezionareLayout
nel men�u Tools , checauser�a la comparsaanchedella �nestra LSW. Si consigliavivamente
di salvareil lavorosvolto conDesign -> Save as... , utilizzandoperesempiolayout
comenomemnemonicoperla vista.
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Figura24: LayoutcompletoottenutoconPlace& Routeautomatici
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